Thank you for purchasing our product.
Carefully read this instruction manual before using this unit.
Notices about this User's Manual
In order to properly use this product, please carefully read this manual before using.

T&D Corporation accepts no responsibility for any malfunction of and/or trouble with this product or with your computer that is caused by the improper handling of this product and will deem such trouble or malfunction as falling outside the conditions for free repair outlined in the attached warranty.

- All rights of this User's Manual belong to T&D Corporation. It is prohibited to use, duplicate and/or arrange a part or whole of this User's Manual without the permission of T&D Corporation.

- Microsoft and Windows are registered trademarks of Microsoft Corporation in the United States and/or other countries.

- Windows Vista is either a registered trademark or trademark of Microsoft Corporation in the United States and/or other countries.

- Company names and product names are trademarks or registered trademarks of each company.

- Specifications, design and other contents outlined in this manual are subject to change without notice.

- On screen messages in this manual may vary slightly from the actual messages. Please notify the shop where you purchased this product or T&D Corporation of any mistakes, errors or unclear explanations in this manual. T&D Corporation accepts no responsibility for any damage or loss of income caused by the use of our product.

- This product has been designed for private or industrial use only. It is not for use in situations where strict safety precautions are necessary such as in connection with medical equipment, whether directly or indirectly.

- We are not responsible for any malfunction or trouble caused by the use of our product or by any problem caused by the use of measurement results of our unit. Please be fully aware of this before using our product.

- Some of our products, which come under the category of strategic goods in foreign trade law, need the permission of the Japanese government to be exported outside of Japan.

- Please read the warranty and provisions for free repair carefully.
Software User's Agreement

Disclaimers
- Although T&D Corporation has made operational tests on our software "RTR-61 for Windows (US)®", we cannot guarantee that all operations will work properly under all conditions.
- T&D Corporation shall not accept any responsibility for any damage whether direct or indirect that results from the usage of RTR-61 for Windows (US)®.
- Specifications of RTR-61 for Windows (US)® may be subject to change and service may be terminated without advance notice to the user. In such a case, T&D Corporation shall not be responsible for any damages, whether direct or indirect, from the inability to use RTR-61 for Windows (US)®.
- T&D Corporation has no obligation to correct any defects found in RTR-61 for Windows (US)®.

Copyright
- All copyrights RTR-61 for Windows®, including all of the programs and all related documents, are the sole property of T&D Corporation.
- The reprinting or redistribution for commercial purposes whether in part or in whole, in magazines or as a part of any product is strictly forbidden without the expressed consent of T&D Corporation. Any inquiries concerning commercial redistribution should be directed to the Sales Department of T&D Corporation.
- Please do not attempt to make any changes or modifications to RTR-61 for Windows (US)®.

* RTR-61 for Windows (US)® includes [Network Settings Utility], [RTR-61 for Windows], [RTR-61 Registration] and [RTR-61 Data Viewer].
Safety Precautions and Instructions

To ensure the safe use of RTR-5W and RTR-50
The following items should be strictly obeyed for the safe usage of this unit, and for protecting yourself and other people from bodily harm and/or damage to property. To ensure the proper use of our product, please read the following carefully and fully understand the contents.

Explanation of Symbols

Explanation of Warning Symbols

| ⚠️ DANGER | These entries are actions that absolutely under no circumstance should be taken. The taking of such an action may cause serious personal physical damage or death. |
| ⚠️ CAUTION | These entries are actions that if taken may lead to physical injury or damage to persons or things. |

Explanation of Picture Symbols

| ▲ | Denotes an important warning or caution. Inside or near the symbol will appear another symbol giving details. |
| ☠️ | Denotes a forbidden action. Inside or near the symbol will appear another symbol giving details. |
| ⬤ | Denotes an action that you must take. Inside or near the symbol will appear another symbol giving details. |
**DANGER**

- Be sure to follow the warnings and notices about use from your PC maker when installing and using this unit.

- Do not take apart, repair or modify the main unit. Doing so may cause fire or electrocution.

- If water or a foreign body enters in this unit, turn the power off and remove the batteries. Continued use may cause fire or electrocution.

- Do not use this unit in wet or humid places, such as a bathroom. It may cause a fire or other trouble including malfunction.

- Store main units, batteries and communication cables out of the reach of children. It is dangerous to touch or swallow batteries.

- Do not connect the communication cable to a telephone line. It may cause a fire or other trouble including malfunction.

- If any smoke or strange smells are emitted from the unit, immediately remove the batteries and stop using. Continued use may cause fire or electrocution.

- Do not drop the unit, or expose the unit to a strong impact. If that happens to the unit, immediately turn the power OFF and remove the batteries. Continued use may cause fire or electrocution.

- Do not unplug the AC adaptor or re-install batteries with wet hands. This may cause electrocution.
CAUTION

We are not responsible for any damage, malfunction or trouble, whether direct or indirect, caused by the use of our product. Please be fully aware of this before using our product.

This product has been designed for private or industrial use only. It is not for use in situations where strict safety precautions are necessary such as in connection with medical equipment, whether directly or indirectly.

Harmful gases or chemicals may cause corrosion and/or other danger to the unit. Also, by coming in contact with hazardous substances, harm may occur to the people handling the unit. Therefore, do not use in any environment that is exposed to chemicals and harmful gases.

To prevent damage to the unit from static electricity, remove static electricity from your body by touching metal around you (door knob, window frame) before touching the unit. Static electricity may cause not only damage to the unit, but may cause breaks in or a loss of data.

This unit is not waterproof. If the unit gets dirty, wipe it with a clean cloth dipped in alcohol.

Please do not insert your fingers or any foreign objects into the connection jacks.

Do not use or store the products in any of the following places. Doing so may cause electrocution, fire and/or other adverse effects to the device and/or your computer.

- Areas exposed to direct sunlight.
  This will cause the inside of the device to become overheated and may cause fire, deformation, and/or other damage including malfunction.

- Areas prone to strong magnetic fields.
  This may cause damage including malfunction.

- Areas exposed to water leakage.
  This may cause electrocution or other damage including malfunction.

- Areas exposed to excessive vibration
  This may cause injury, malfunction.

- Areas that are not flat or level
  This may cause the unit to fall and result in injury and/or damage.

- Areas near fire or exposed to excessive heat
  This may cause damage including malfunction and deformation.

- Areas prone to smoke, duct and dirt
  This may cause damage including malfunction.
Battery life depends on the measurement environment, communication frequency, recording interval and battery quality.

Do not use any other batteries than those that are specified in this User's Manual. It may cause a fire or other trouble including malfunction.

Battery terminals may provide insufficient contact due to age or vibration. This may lead to data loss.

Condensation may occur if the unit is moved from one environment to another where the difference in temperature is great. Use the unit in an environment where the ambient temperature is from -10°C to 60°C and the humidity is 90% RH (no condensation) or less.

Make sure that the LAN cable and AC adaptor are inserted fully, so as not to cause an improper connection.

Also, when unplugging the LAN cable from the main unit, do not pull the cord, but hold the connector to disconnect.

Do not put anything on top of the AC adaptor. This may cause overheating.

Condensation may occur if the unit is moved from one environment to another where the difference in temperature is great. Use the unit in an environment where the ambient temperature is from 0°C to 60°C and the humidity is between 20% and 80% RH (no condensation). If you are using a Wireless LAN card, please follow all instructions included with the card.
This device complies with part 15 of the Federal Communications Commission (FCC) rules and with RSS-210 of the Industry Canada (IC).

Operation is subject to the following conditions:
(1) This device may not cause harmful interference, and
(2) This device must accept any interference received, including interference that may cause undesired operation.

NOTE:
- This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio communications. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:
  - Reorient or relocate the receiving antenna.
  - Increase the separation between the equipment and receiver.
  - Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
  - Consult the dealer or an experienced radio/TV technician for help.
- The user is cautioned that changes or modifications not expressly approved by T&D Corporation, could void the user’s authority to operate the equipment.
Table of Contents

Notices about this User’s Manual -------------- 2
Software User’s Agreement ------------------ 3
Safety Precautions and Instructions -------4
To ensure the safe use of RTR-5W and RTR-50-4
Explanation of Symbols --------------------- 4
Table of Contents -------------------------- 10
What is Web Wing WL RTR-5W ? ---------- 12
General Procedure for using an RTR-5W --- 13
as a Base Unit (via a Network) ----------- 13
What is Communication Port RTR-50? -- 14
General Procedure for using an RTR-50---- 15
as a Base Unit (via a Wireless)----------- 15
What is "RTR-61 for Windows (US)?" --- 16

1. Getting Ready
Getting RTR-5W Ready to Use :
RTR-61SK-W ------------------------------- 18
Package Contents ------------------------ 18
RTR-5W Part Names and Functions ------ 19
Checking your Operating Environment -- 20
Connecting Supplied LAN Cable ------- 21
Connecting Supplied AC Adaptor ------- 21
Connecting to a Network ----------------- 22
Connection Example --------------------- 22
Connecting to the Internet............... 24
Connection Example --------------------- 24
Getting the RTR-50 Ready to Use :
RTR-61SK ---------------------------------- 26
Package Contents ------------------------ 26
RTR-50 Part Names and Functions ------ 26
Installing batteries for Repeater(s)---- 27
Installing Software "RTR-61 for Windows (US) "--- 28
For Windows XP ------------------------ 28
For Windows Vista / 7 ------------------- 29
Using Applications --------------------- 31
How to Open ---------------------------- 31
Launcher ------------------------------- 31
Using Help ----------------------------- 32
Before using the RTR-50 ------------- 33
Installing the USB Device Driver ------ 34
Installation Procedure by Operating System --- 35
For Windows Vista / 7 ------------------- 35
For Windows® XP ------------------------ 36
If USB Device Driver Installation Fails -- 40
For Windows Vista / 7 ------------------- 40

2. Network Settings Utility
Network Settings Utility --------------- 42
Main Items in the Network Settings Utility ---- 42
Menu ----------------------------------- 43
Network Initialization Settings ------- 44
Detailed Network Settings -------------- 46
Receiving Settings --------------------- 46
Making Settings (Changes)------------- 47
[Re-activate Communication] button ----- 48
Returning Network Settings to Factory
Default Settings ---------------------- 49

3. RTR-61 Registration
Image of Registration ------------------ 52
Base Unit -------------------------- 52
About Repeaters --------------------- 52
Basic Procedure for Registration ---- 54
Making a New Base Unit Registration -- 55
Basic Procedure for Registration: ---- 55
Modifying and Deleting Registration Contents: - 56
Remote Unit Registration -------------- 57
About Optical Communication with Remote Units -- 57
New Registration --------------------- 58
Repeater Registration ---------------- 61
Registration List --------------------- 62
Connecting a Remote Unit via Repeater(s) ---- 63
Removing a Remote Unit from a Relay Route -- 64
Selecting Menu in Registration List ----- 64
Confirming Remote Unit Info
Deleting / Initializing Remote Unit ---- 65
Confirming Remote Unit Info ------------- 65
Deleting Remote Unit / Group --------- 65
Initializing Remote Unit --------------- 66
Confirming Repeater Info
Deleting / Initializing Repeater -------- 67
Confirming Repeater Info --------------- 67
Deleting Route / Repeater ------------ 67
Replacing Repeater ------------------- 68
Initializing Repeater (Returning to Base Unit) -- 69
Getting Base Unit / Repeater Info
(Direct Communication) -------------- 70
RTR-50 Battery life and Battery Replacement-- 70
Wireless Communication Test ---------- 71
If Placing Repeater(s) --------------- 71
Wireless Communication Test Results -- 72
Checking Network Connection ---------- 72
4. How to use "RTR-61 for Windows"

4.1 About [File] Menu

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>About the Display</td>
<td>76</td>
</tr>
<tr>
<td>Main Window</td>
<td>76</td>
</tr>
<tr>
<td>Communication Log</td>
<td>77</td>
</tr>
<tr>
<td>Item Table: [File] Menu</td>
<td>78</td>
</tr>
<tr>
<td>Displaying [Item Table] Window</td>
<td>78</td>
</tr>
<tr>
<td>Creating Item Tables</td>
<td>80</td>
</tr>
<tr>
<td>Sending Item Tables</td>
<td>82</td>
</tr>
<tr>
<td>Getting Item Tables</td>
<td>83</td>
</tr>
<tr>
<td>Inserting / Deleting / Correcting Item Tables</td>
<td>83</td>
</tr>
<tr>
<td>Deleting the Contents of an Item Table</td>
<td>85</td>
</tr>
<tr>
<td>Saving Item Tables in Text File /</td>
<td>85</td>
</tr>
<tr>
<td>Reading Text File Formatted Item Tables</td>
<td>85</td>
</tr>
<tr>
<td>Other Menus</td>
<td>86</td>
</tr>
<tr>
<td>User Table: [File] Menu</td>
<td>87</td>
</tr>
<tr>
<td>Displaying [User Table] Window</td>
<td>87</td>
</tr>
<tr>
<td>Creating User Tables</td>
<td>88</td>
</tr>
<tr>
<td>Sending User Tables</td>
<td>90</td>
</tr>
<tr>
<td>Getting User Tables</td>
<td>91</td>
</tr>
<tr>
<td>Inserting / Deleting / Correcting User Tables</td>
<td>91</td>
</tr>
<tr>
<td>Deleting Contents of User Tables</td>
<td>92</td>
</tr>
<tr>
<td>Saving User Tables in Text File /</td>
<td>93</td>
</tr>
<tr>
<td>Reading Text File Formatted User Tables</td>
<td>93</td>
</tr>
<tr>
<td>Other Menus</td>
<td>93</td>
</tr>
<tr>
<td>[Communication] Menu</td>
<td>94</td>
</tr>
<tr>
<td>Selecting the [Communication] Menu</td>
<td>94</td>
</tr>
<tr>
<td>for Wireless Communication</td>
<td>94</td>
</tr>
<tr>
<td>Selecting the [Communication] Menu</td>
<td>95</td>
</tr>
<tr>
<td>for Optical Communication</td>
<td>95</td>
</tr>
<tr>
<td>Operational Settings</td>
<td>96</td>
</tr>
<tr>
<td>Open the [Operational Settings] Window</td>
<td>96</td>
</tr>
<tr>
<td>Making Settings in the [Required Settings to Send] Area</td>
<td>96</td>
</tr>
<tr>
<td>Making Recorded Data File Settings</td>
<td>100</td>
</tr>
<tr>
<td>RTR-61 Clock Settings</td>
<td>101</td>
</tr>
<tr>
<td>Downloading Recorded Data</td>
<td>102</td>
</tr>
<tr>
<td>About File Names and Locations for Downloaded Data</td>
<td>103</td>
</tr>
<tr>
<td>About Downloaded Data Files</td>
<td>103</td>
</tr>
<tr>
<td>Checking Downloaded Data</td>
<td>104</td>
</tr>
<tr>
<td>Getting Remote Unit Info</td>
<td>105</td>
</tr>
<tr>
<td>Erasing Recorded Data</td>
<td>106</td>
</tr>
<tr>
<td>Sending Messages</td>
<td>107</td>
</tr>
<tr>
<td>Remote Measurement Commands</td>
<td>108</td>
</tr>
<tr>
<td>Messages shown during communication of a Measurement Command</td>
<td>109</td>
</tr>
<tr>
<td>Communication Results</td>
<td>110</td>
</tr>
<tr>
<td>Checking Data</td>
<td>111</td>
</tr>
<tr>
<td>Data Files Recorded by Remote Measurement Command</td>
<td>112</td>
</tr>
<tr>
<td>Adjustment Function</td>
<td>113</td>
</tr>
<tr>
<td>About Adjustment Methods</td>
<td>114</td>
</tr>
</tbody>
</table>

5. How to Use "RTR-61 Data Viewer"

5.1 About [File] Menu

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>About the Display</td>
<td>118</td>
</tr>
<tr>
<td>About File Names</td>
<td>118</td>
</tr>
<tr>
<td>Opening Saved Data</td>
<td>119</td>
</tr>
<tr>
<td>Dragging and Dropping Data Files</td>
<td>119</td>
</tr>
<tr>
<td>Uploading Additional Data Files</td>
<td>120</td>
</tr>
<tr>
<td>Remote Unit Info</td>
<td>120</td>
</tr>
<tr>
<td>[File] Menu</td>
<td>121</td>
</tr>
<tr>
<td>Saving Data</td>
<td>121</td>
</tr>
<tr>
<td>Exporting Text Data</td>
<td>121</td>
</tr>
<tr>
<td>Print</td>
<td>122</td>
</tr>
<tr>
<td>Print Preview</td>
<td>122</td>
</tr>
<tr>
<td>[Edit] Menu</td>
<td>124</td>
</tr>
<tr>
<td>[View] Menu</td>
<td>125</td>
</tr>
<tr>
<td>Item View</td>
<td>125</td>
</tr>
<tr>
<td>Changing Temperature Unit</td>
<td>126</td>
</tr>
<tr>
<td>Changing Date / Time Format</td>
<td>126</td>
</tr>
<tr>
<td>Changing the Display Widths</td>
<td>127</td>
</tr>
</tbody>
</table>

6. Others

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Recorded Data and Log Data</td>
<td>130</td>
</tr>
<tr>
<td>Opening a Program File (one example)</td>
<td>130</td>
</tr>
<tr>
<td>Troubleshooting</td>
<td>131</td>
</tr>
<tr>
<td>Network Settings Utility</td>
<td>131</td>
</tr>
<tr>
<td>Q&amp;A</td>
<td>133</td>
</tr>
<tr>
<td>Q&amp;A about RTR-5W</td>
<td>133</td>
</tr>
<tr>
<td>Q&amp;A about Networks</td>
<td>134</td>
</tr>
<tr>
<td>Q&amp;A about the Internet</td>
<td>137</td>
</tr>
<tr>
<td>Q&amp;A about RTR-61 for Windows</td>
<td>139</td>
</tr>
<tr>
<td>Specifications</td>
<td>141</td>
</tr>
<tr>
<td>Software &quot;RTR-61 for Windows&quot;</td>
<td>141</td>
</tr>
<tr>
<td>RTR-61SK</td>
<td>142</td>
</tr>
<tr>
<td>RTR-61SK-W</td>
<td>143</td>
</tr>
<tr>
<td>Options</td>
<td>144</td>
</tr>
<tr>
<td>For RTR-50 (When used as a Repeater)</td>
<td>144</td>
</tr>
<tr>
<td>For RTR-5W</td>
<td>144</td>
</tr>
<tr>
<td>Base Unit Warranty</td>
<td>On Back</td>
</tr>
</tbody>
</table>
What is Web Wing WL RTR-5W?

The RTR-5W not only serves as a base station for the wireless downloading of recorded data from our Push Wireless RTR-61 Series Data Loggers, but, moreover, the Web Wing WL RTR-5W serves as a network base station that allows you to gather recorded data via LAN or Internet connection.

NOTE:
- The RTR-5W is designed solely for network communication. It does not include any RS-232 or USB communication interface. To make use of this product you must connect it to a network. Moreover, in order to use this product via the Internet you will need other devices (such as a router) and must first make necessary arrangements with a provider for a line and get a fixed IP address, domain, etc....
- When making settings in an RTR-5W without any settings already made (when purchased or after resetting), it is necessary to carry out these settings using a wired LAN connection. After having made all the necessary settings via the wired connection, it is possible to use a wireless LAN connection.

NOTE: About the Explanation of RTR-5W
- This manual only provides information about RTR-5W which is necessary in order to carry out operations with "RTR-61 for Windows (US)."
- For more detailed info about RTR-5W functions, see the product introduction page on our Website.

Compatible RTR-5W:
- Internal Script Version 1.45 or above
- RF Version 1.4.x or above
General Procedure for using an RTR-5W as a Base Unit (via a Network)

Getting Ready

1. Getting an Remote Unit (RTR-61) Ready to Use
   - Install the batteries and sensor (See the RTR-61 User's Manual)

2. Getting the Base Unit (RTR-5W) Ready to Use
   - Check your operational settings and network environment for the RTR-5W.
   - Connect the RTR-5W to the Computer.

3. Getting the Repeater (RTR-50) Ready to Use
   - When the use of a Repeater is necessary, after considering the wireless communication distance, determine the needed number of Repeaters.
   - Install batteries into the Repeater(s).

4. Install the software "RTR-61 for Windows (US)"

5. Installing the USB Device Driver for RTR-50
   - Only necessary when using as a Repeater.

Software "RTR-61 for Windows (US)"

6. Make Network Initialization settings in the "Network Settings Utility"

7. Under "RTR-61 for Windows (US)" make registration settings for a Base Unit, Remote Units and Repeaters

8. Various Settings to be made in "RTR-61 for Windows (US)"
   - Create Item and User Tables, then register this info into Remote Units.
   - Operational Settings (Recording Mode / Judgment LED / Other Settings).

9. Start Recording

10. Download Recorded Data

11. View / Save / Print Data List from "RTR-61 Data Viewer"
What is Communication Port RTR-50?

The Wireless Communication Port RTR-50 (Unit Ver.2-1-x or higher) is a base unit designed to carry out wireless communication with our RTR-61 and to be connected to a computer via a USB cable to gather data from and control the loggers. Also, by setting up an RTR-50 between the RTR-50 designated as the Base Unit and the RTR-61 Remote Data Logger Unit, you can use any RTR-50 as a Repeater for wireless communication.

**NOTE:**
- "RTR-61 for Windows (US)" can only be used when the PC communication connection is with a USB Cable.
- RTR-50 (Ver.2-1-x) can also be used with our Thermo Recorder RTR-5 Series loggers if software designed for that purpose is used. Please see our Website for details.
- In order to carry out wireless communication between an RTR-61 Data Logger and an RTR-50 Base Unit, it is first necessary to register the Data Logger as a Remote Unit of that RTR-50 via optical communication using the supplied optical communication adaptor (RTR-06A1).
- If the distance between an RTR-50 Base Unit and an RTR-61 Remote Unit exceeds the possible range of wireless communication, it is possible to set up one or, if necessary, multiple RTR-50 Unit(s) as Repeater(s) between them in order to route wireless communication from the Base Unit to the Remote Unit.
General Procedure for using an RTR-50 as a Base Unit (via a Wireless)

Getting Ready

1. Getting an Remote Unit (RTR-61) Ready to Use
   - Install the batteries and sensor (See the RTR-61 User's Manual)

2. Getting the Base Unit (RTR-50) Ready to Use

3. Getting the Repeater (RTR-50) Ready to Use
   - When the use of a Repeater is necessary, after considering the wireless communication distance, determine the needed number of Repeaters.
   - Install batteries into the Repeater(s).

4. Install the software "RTR-61 for Windows (US)"

5. Installing the USB Device Driver for RTR-50

Software "RTR-61 for Windows (US)"

6. Under "RTR-61 for Windows (US)" make registration settings for a Base Unit, Remote Units and Repeaters

7. Various Settings to be made in "RTR-61 for Windows (US)"
   - Create Item and User Tables, then register this info into Remote Units.
   - Operational Settings (Recording Mode / Judgment LED / Other Settings)

8. Start Recording

9. Download Recorded Data

10. View / Save / Print Data List from "RTR-61 Data Viewer"
What is "RTR-61 for Windows (US)"?

"RTR-61 for Window (US)" is software designed to be used with our wireless core temperature data logger, RTR-61. This user friendly software enables the user to download data, view data lists and save data to files, as well as make important logger settings. Using our exclusive short-range wireless technology it is possible to carry out Remote Unit Registrations and make Operational Settings between an RTR-50 or RTR-5W Base and RTR-61 Data Loggers via wireless communication. If you wish to use an RTR-50 as a Repeater, it is also possible to carry out Repeater Registration and make other Operational Settings.

- The wireless communication range, if unobstructed and direct, is about 100 meters [330 ft].
- Depending on the location of loggers, Repeaters may be necessary for communication.
1. Getting Ready

This section provides instructions on getting ready to install the supplied software.
Package Contents
The following items are included in the package.

- Web Wing WL RTR-5W x1
- CD-ROM RTR-61 for Windows (US) x1
- LAN Cable LN-20W x1
- AC adaptor AD-0605 x1
- Optical Communication Adaptor (RTR-06A1) x1
- User's Manual (Warranty) x1
RTR-5W Part Names and Functions

[FONT]

**POWER LED**
While the power is ON, the lamp will be on.

**Optical Communication Area**
When you wish to communicate directly, not by wireless, with a data logger (Remote Unit), it is necessary to place the logger (Remote Unit) face down on this area for communication to occur.

[LEFT SIDE]

- **Ethernet Jack**
  - 10Base-T/100Base-TX Ethernet Connector
  - Connect with LAN Cable

- **AC Adaptor Jack**
  - Connect using the supplied AC adaptor

[RIGHT SIDE]

- **CF Interface slot**
  - Insert a Wireless LAN Card

- **<Reset> Button**
  - Press to return to the factory default settings

* For information and updates concerning which CF cards can be used please see our Website. Or contact the agent from which you purchased the unit.
Checking your Operating Environment
To properly use the logger, the following operational environment is necessary.

PC Operating Environment

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>OS</strong></td>
<td>Microsoft Windows 7 32/64bit English</td>
</tr>
<tr>
<td></td>
<td>Microsoft Windows Vista 32bit English</td>
</tr>
<tr>
<td></td>
<td>Microsoft Windows XP 32bit(SP2 or above) English</td>
</tr>
<tr>
<td></td>
<td>*For installation, it is necessary to have Administrator (Computer Administrator) rights.</td>
</tr>
<tr>
<td><strong>PC/CPU</strong></td>
<td>A Stable Windows Operating Environment</td>
</tr>
<tr>
<td><strong>LAN TCP/IP</strong></td>
<td>Communication Possible</td>
</tr>
<tr>
<td><strong>Memory</strong></td>
<td>Enough memory to stably operate Windows®</td>
</tr>
<tr>
<td><strong>Hard Disk</strong></td>
<td>More than 20 MB of free space (Data will need more space)</td>
</tr>
<tr>
<td><strong>Monitor</strong></td>
<td>SVGA (higher than 800 x 600 recommended) more than 256 colors</td>
</tr>
<tr>
<td><strong>LAN</strong></td>
<td>100BASE-TX or 10BASE-T</td>
</tr>
<tr>
<td></td>
<td>Twisted pair cable conforming to Category 5 (STP/UTP)</td>
</tr>
</tbody>
</table>

[Using a LAN]
Connect the provided LAN cable to the HUB that is connected to your computer.

[Connecting Directly to a PC]
Connect the RTR-5W to your computer with a LAN cross cable.
* LAN cross (reverse) cables are not included with the product. Please purchase separately.

[Using a Wireless LAN]
Please use a Wireless LAN card and a Wireless LAN access point (Combined Wireless LAN and Hub OK).
* For information and updates concerning which wireless LAN cards can be used, please contact your local T&D dealer or representative.

[Using the Internet]
In order to connect to the Internet, you must first make arrangements with a provider for a line.
It may also be necessary to get an IP address or domain and make domain name server and other settings.
For more details about various settings, it is best, if present, to contact the network administrator. To get more details about your Internet connection and setup, please contact your provider.
Connecting Supplied LAN Cable

NOTE:
- To ensure a proper connection make sure that the connector is completely inserted.

Connecting Supplied AC Adaptor

NOTE:
- To ensure a proper connection make sure that the plug is completely inserted.
- Do not use an AC adaptor other than the one that is supplied with the product. Doing so may cause fire or other trouble.
- Insert the AC adaptor plug into an AC 100V to 120V socket. Inserting the plug into a socket with different voltage may cause fire or other trouble.
- Do not insert or pull out the AC adaptor plug with wet hands or if there are water drops on the plug; it may cause electrocution.
Connecting to a Network

The following are some ways to connect an RTR-5W to a network. Please select the connection method that suits your network environment.

**NOTE:**
- To ensure a proper connection make sure that the plug is completely inserted.

**Connection Example**

Connecting to a HUB for in-company Communication

![Diagram of RTR-5W connected to a HUB through a LAN-cable]

Connecting Directly to PC for Communication

Do not use the supplied cable; please purchase a cross LAN cable separately.

![Diagram of RTR-5W connected directly to PC through a LAN Cross Cable]
Connecting to a Wireless LAN

By inserting a Wireless LAN card into the RTR-5W, it is possible to carry out communication in places where LAN wiring is difficult or troublesome.

**NOTE:**
- To ensure a proper connection make sure that the wireless LAN card is completely inserted.
- Before you insert or take out the LAN card, make sure that the AC adaptor is unplugged.
- For information and updates concerning which wireless LAN cards can be used, please contact your local T&D dealer or representative.

* External HUB is not necessary if wireless LAN access point has a built in HUB / Router.
Connecting to the Internet

In order to connect the RTR-5W to the Internet, you must first set up an Internet connection environment by making arrangements with a provider for a line and get a global IP address and domain. Also, if necessary, make all domain name server and / or router settings. For more details about various settings, it is best, if present, to contact the network administrator. To get more details about a global IP address and domain, please contact your provider.

The following are examples of connection methods. Please select the connection method that suits your network environment.

Connection Example

Using the RTR-5W on the Internet

① In order to access the RTR-5W from your browser, enter the Global IP address that has been assigned to the RTR-5W in your browser's URL bar following [http://]
② The RTR-5W will be called via a router or the Internet provider.
③ The RTR-5W which received the access request will return data to the computer which sent the access request.
Using a Domain Name (ex: rtr-5w.net)

1. In order to access the RTR-5W from your browser, enter the Domain Name (Ex: rtr-5w.net) that has been assigned to the RTR-5W in your browser's URL bar following [http://].

2. The Domain Name that was entered in the URL bar is converted by the DNS server into an IP address and the RTR-5W is called.

3. The RTR-5W which received the access request will return data to the computer which sent the access request.
Getting the RTR-50 Ready to Use : RTR-61SK

■Package Contents
The following items are included in the package.

<table>
<thead>
<tr>
<th>Item</th>
<th>Quantity</th>
</tr>
</thead>
<tbody>
<tr>
<td>Communication Port RTR-50 (Ver.2-1-x or higher)</td>
<td>x1</td>
</tr>
<tr>
<td>CD-ROM RTR-61 for Windows (US)</td>
<td>x1</td>
</tr>
<tr>
<td>USB Cable (US-15C)</td>
<td>x1</td>
</tr>
<tr>
<td>Optical Communication Adaptor (RTR-06A1)</td>
<td>x1</td>
</tr>
<tr>
<td>User's Manual (Warranty)</td>
<td>x1</td>
</tr>
<tr>
<td>Memo Sticker *</td>
<td>x1</td>
</tr>
</tbody>
</table>

* Please write Repeater names, numbers or any other memos on the sticker and fasten it to the unit.

■RTR-50 Part Names and Functions

[Front]

Monitor LED
RS-232C (Serial) AC Adaptor Connection Jack

NOTE:
- "RTR-61 for Windows (US)" can only be used when the PC communication connection is with a USB Cable.

Installing batteries for Repeater(s)

Only necessary when using Repeater(s)
When using an RTR-50 unit as a Repeater, insert 2 AA alkaline batteries as shown in the figure. The Monitor LED will blink once when usable batteries are installed.

NOTE:
- Always use two batteries of the same type.
- Make sure not to mistake + / -.
- Instead of batteries, it is possible to use an AC adaptor or connect to some other external power supply. See "Options" (page 142).
Getting Ready

Installing Software "RTR-61 for Windows (US)"

Is Windows® operating properly?
If Windows is not operating properly, RTR-61 for Windows (US)® may not be installed correctly or it may not operate properly.

Please quit all other applications.
If other programs are open, please close and quit all of them, making sure to quit all Quick Start programs such as a virus checker.

* The layout of the installation window for “Windows 7” closely resembles that of “Windows Vista”. When using “Windows 7” to install the Software, please refer to the installation instructions found under “Windows Vista” in the User’s Manual provided with the product and follow on-screen messages as they appear.
For information about operating the software, please carefully read the important notices and instructions found in the User’s Manual.

For Windows XP, Vista and 7, in order to install "RTR-61 for Windows (US)", it is necessary to have Administrator rights (Computer Administrator) for the computer in which you wish to install it.

For Windows XP

1. Open Windows.

2. Place the accompanying CD-ROM into your CD-ROM drive. In a few seconds, the [Install Program] window will appear.
   - If that window does not automatically open, please open it by double clicking the CD-ROM icon in "My Computer" on your desktop.
   - Or, if after double clicking the CR-ROM drive, the file appears in the CD-ROM folder, double click on the "start.exe" icon.

3. Select [Install RTR-61 for Windows] and click the [Execute] button to start the installation.
4. Continue the installation by following the directions as they appear.

5. After installation has been completed, RTR-61 for Windows (US) will be registered in Window's [Start] Menu.

For Windows Vista / 7

1. Open Windows

2. Insert the attached CD-ROM in the CD-ROM drive.
   - If the [Auto-play] window appears, under [Install or run program], click on [Run start.exe].

   ![Auto-play Window]
   Once this window appears, please click here.

3. The "Install Program" window should appear soon.
   - If the "Install Program" Window does not automatically open, go to [Computer] and open it by double clicking on the CD-ROM icon.

   ![Install Program Window]
   [Execute] Button
   Select this
4. Select [Install RTR-61 for Windows], then click the [Run] button and the [User Account Controls] window should appear.

5. Click [Next] to start the installation. Continue the installation by following the directions as they appear.

6. After the software has been installed, the following message will appear: Click the [Install] button.

7. After installation has been completed, "RTR-61 for Windows (US)" will be registered in Windows' [Start] Menu.
Using Applications

How to Open
From the list of programs in the Window's Start Menu, click on RTR-61 for Windows(US).

Launcher
"RTR-61 for Windows (US)" is made up of four applications. By clicking on "RTR-61 for Windows (US)" the Launcher Window will appear.

[Network Settings Utility]
This application is a set of tools to help make settings for connecting an RTR-5W to a network.

[RTR-61 Registration]
This application is designed to carry out Base Unit (RTR-5W / RTR-50), Repeater (RTR-50) and Remote Unit (RTR-61) Registration.

[RTR-61 for Windows]
This application is designed for the management of RTR-61 data loggers, including making the various settings and downloading data.

[RTR-61 Data Viewer]
This application enables the viewing in list form of data downloaded from RTR-61 data loggers.
Using Help

For details about how to use the software, please see the explanations in the Software Help Menu.

By clicking on [Help] in the Menu Bar and then click on one of the tabs [Contents] or [Index] to search for the topic or term you are unsure about or have questions about.

[Contents]
By clicking on one of the topics listed, you can find detailed information for that subject.

[Index]
By selecting a Keyword in the Keyword list, and clicking the [Display] button at the bottom, a detailed explanation will appear.

- By clicking the help button ![Help] in a Window, an explanation for that Window will appear.
Before using the RTR-50

Have you installed the software that comes with the RTR-50?
Make sure to install the provided software before connecting the RTR-50 to your PC.

If you do connect the unit before installing, make sure to click the "Cancel" button in the Wizard window when it appears.

Wizard display for Vista

* For other Windows OS, there is also a [Cancel] button in the lower right of the screen.

- If you connect the RTR-50 to the computer before installing the software, the USB device driver may not be installed properly.
Installing the USB Device Driver

Before using the RTR-50, it is necessary to install the USB device driver. After installing the USB device driver, your computer will be able to detect and recognize any RTR-50 that has been connected with a USB cable.

1. Connect the supplied USB cable to a USB port on your computer.

![USB Cable Diagram]

- **USB Port Mark**: The USB communication cable is a USB-A plug ↔ USB mini-B plug. Connect to a place with a mark as such.

2. Insert the attached CD-ROM in the CD-ROM drive. If the Installation Window opens, close it.

3. Connect an RTR-50 to the USB cable already connected to your computer.

4. Please install the USB Device Driver. The installation procedure differs slightly depending upon which OS is being used; please refer to the procedure for the OS being used.

   - **Vista / 7** .......................................................... p.35
   - **XP** ................................................................. p.36 - p.39
   - **If USB Device Driver Installation Fails** .... p.40
Installation Procedure by Operating System

For Windows Vista / 7
For Windows Vista and 7, by installing the provided software, the USB device driver will also be automatically installed.

* When using "Windows 7" to install the USB Device Driver, please refer to the installation instructions found under “Windows Vista” in the User’s Manual provided with the product and follow on-screen messages as they appear.

For Windows Vista and 7, in order to install "RTR-61 for Windows (US)", it is necessary to have Administrator rights (Computer Administrator) for the computer in which you wish to install it.

Checking for the USB Driver (Windows Vista / 7)
1. Connect an RTR-50 to the Computer. (See page 34 for details)
2. Open the "Control Panel" and click on "System and Maintenance" - "System" - "Device Manager".
   - If you are using the "Classic" view, click the "Device Manager" icon.
3. In the Device Manager Window, check to see if [USB Recorder 2] is listed under [USB Recorder COM].
   - If the [Other devices] or [Unknown device] icon with an exclamation or a question mark appears in the Device Manager Window, see the "If USB Device Driver Installation Fails" (p.40).
For Windows® XP

For Windows XP, in order to install “RTR-61 for Windows (US)”, it is necessary to have Administrator rights (Computer Administrator) for the computer in which you wish to install it.

1. Turn on your computer and open Windows.

2. Connect an RTR-50 to the Computer. (See page 34 for details)

3. Insert the attached CD-ROM in the CR-ROM drive.

   - If it does not automatically open, please see the next page.
   - If a window appears such as the one below, check [No, not this time] and then click the [Next] Button.

   ![Found New Hardware Wizard]

   * Windows such as this will not appear for [No Service Pack] and [Service Pack 1] versions.

   Check [No, not this time]

   [Next] Button

5. By checking [Install the software automatically (Recommended)] and clicking [Next], the software will automatically be installed.

   ![Found New Hardware Wizard]

   Check [Install the software automatically (Recommended)]

   [Next] Button

6. After completing installation, click the [Finished] Button. Confirm the Connections.
If the Driver is not automatically detected (Windows XP)

1. Disconnect the USB cable from RTR-50 and then re-connect it.
2. The [Add New Hardware Wizard] will automatically open.

   * Windows such as this will not appear for [No Service Pack] and [Service Pack 1] versions.

3. By checking [Install from a list or specific location (Advanced)] and clicking [Next], the installation process will begin.
4. Place a check next to [Include this location in the search: ], click the [Browse] Button and specify the location of the driver.

Select the driver for the device being used from the folder where "RTR-61 for Windows (US)" was installed.
EX   C:\Program Files\RTR-61 for Windows (US)\Driver RTR-50
Insert the CD-ROM into the proper drive and from the CD-ROM select the driver for the device being used.
CD-ROM Drive\DeviceDriver RTR-50

5. After having selected the correct driver, click [Next] to start the installation.

6. After completing the installation, click the [Finished] Button.
Confirming Connection for Windows® XP

1. Connect an RTR-50 to the Computer. (See page 34 for details)

2. Open the [Control Panel] and double click on [System]; the [System Properties] will be displayed.

3. Click the [Hardware] tab, and click the [Device Manager] button in the [Device Manager] Area.

4. In the Device Manager Window, check to see if [USB Recorder 2] is listed under [USB Recorder 2 COM].

- If the [Other devices] or [Unknown device] icon with an exclamation or a question mark appears in the Device Manager Window, see the “If USB Device Driver Installation Fails” (p.40).
If USB Device Driver Installation Fails

If, during USB device driver installation, some trouble occurs that results in a failure to install properly, the following display will appear in the Device Manager.

EX: This mark means installation failure.

■ For Windows Vista / 7

Even after having properly installed the provided software, there may be a few cases where USB communication cannot be carried out.

1. Right click on the icon for the "Unknown Device".
2. From the Menu, click on "Uninstall".

Device Manager display for Vista

3. Then, reboot your computer.
   - It is NOT necessary to re-install the software. Connect the USB Cable and check communication.
2. Network Settings Utility

This application is a set of tools to help make settings for connecting an RTR-5W to a network.
Network Settings Utility

From the list of programs in the Window's Start Menu, click on [RTR-61 for Windows(US)]-[Network Settings Utility].

Main Items in the Network Settings Utility

[Network Initialization] Tab
After purchasing a RTR-5W unit, the first step is to make all Network Initialization Settings including assigning an IP Address and a Subnet Mask.

[Detailed Network Settings] Tab
The reception of RTR-5W settings and more detailed network settings can be made here.

NOTE:
- Please open the Network Settings Utility from only one computer at a time in the same network (same broadcast domain).
- If you open the Network Settings Utility on multiple computers in the same network, it may not work properly.
[Login History]
If you wish to disable the History Function, select [Login History] -> [OFF].

[Clear Login History]
Use this to erase the entire login history. By clicking [Clear Login History], a confirmation message will appear. Select "Yes" to erase the entire login history.

[Communication Time Settings]
In the [Detailed Network Settings], communication speed settings can be made. It is possible to change the communication time / speed for all type of communication depending on your network environment. Select the best setting from the 5 choices 1, 2, 3, 4, 5. Normally the setting should be [1 (fastest)].

**NOTE:**
- If during communication problems occur such as, frequent communication errors or data is only partially received, please try setting the Communication Time to a slower number, such as 2 or 3.
Network Initialization Settings

To connect an RTR-5W to a network, it is necessary to enter an IP Address and Subnet Mask that are appropriate for your network. Please note, that upon purchase, all RTR-5W units are set with the same IP address. To make IP address changes, connect one unit at a time and carry out the changes. Do not connect more than one unit with the same address to the network at the same time.

1. Connect the RTR-5W to the same network as to which the computer you have opened [Network Settings Utility] is connected to.

2. Click on the [Network Initialization] Tab and then click on the [Search] button. After clicking, the search results will be shown in about 5 seconds.

* The factory default settings for RTR-5W are as follows: IP Address: "192.168.1.200", Subnet Mask: "255.255.0.0". The MAC address is written on a sticker on the back of the RTR-5W unit.

If no units are detected
- Check the connection between the computer and the RTR-5W.
- Check the hub power switch and the network cable type.
- If some network environments, it may be necessary to make changes to the IP address and subnet mask at the computer side in order to carry out a search.
- Do not use a LAN card which has not been formatted.
3. From the displayed list, select the RTR-5W to which you wish to make settings by clicking on the IP address and click on the [Change Settings] button.

* Also, by double clicking on the IP address, the [Network Settings] window appear

![Select IP Address Button]

4. Enter an IP Address and Subnet Mask.

**NOTE:**
- Make sure to enter an IP Address and Subnet Mask that are appropriate for your network.
- Do not use the same IP address for two different units. It may cause abnormalities to the entire network system.

![Enter an IP address and Subnet mask]

Enter the Login ID and Password

![Login ID and Password]

5. After entering the above, next, enter the Login ID and Password.

- The RTR-5W factory default Login ID is "wsc-user" and the Password is "wsc-passwd". Make any necessary changes to the Login ID and Password in the [Detailed Network Settings]. See page 46 for details.

6. After checking for entry errors, click the [Send] button. After transmission has been completed a message will appear.

7. Click the [OK] button to finish.

- After settings are completed the RTR-5W will automatically restart. During the restarting process, a search cannot be performed, even if you click the [Search] button. Please try again after 30 seconds.
Detailed Network Settings

After making the network initialization settings for the RTR-5W, the reception of RTR-5W settings and more detailed network settings can be made.

* Before making any of these settings, please make sure that the RTR-5W is set with the proper IP address.

Receiving Settings

1. Click the [Detailed Network Settings] Tab.

2. In the "Receive Settings" Area, enter the information for the RTR-5W you wish to make settings for and click the [Get Settings] button. The current settings will appear.

[Settings History]

A list that shows all of the IP addresses and domain names with which successful communication has occurred until now can be viewed in the [Settings History] pull down menu.

If you select an IP address or domain name here, the Login ID, Password and Port Number will be entered automatically.

- Note that if you have turned [OFF] the [Login History] in the [Menu], or if you have deleted the Login history by having clicked [Clear Login History] the Settings History will not appear.
Making Settings (Changes)

1. In the [Detailed Network Settings] window, click the [Change Settings] button and make any necessary changes.

![Change Settings] Button

2. After making the settings, enter the info for the recipient of the settings and click the [Send Settings] button.

- For details about making settings changes, see the [Help] Menu in the [Network Settings Utility].

3. A message will appear asking you if it is OK to restart the system. Click the [Yes] button to restart.

- The new settings will not become valid until the RTR-5W communication function is restarted.
[Re-activate Communication] button

If the browser does not open, wireless communication continually results in failure, or if any errors occur during communication, click the [Re-activate Communication] button.

**NOTE:**
- Note that by clicking the [Send Settings] button or the [Re-activate Communication] button over and over, communication may become impossible. Please try again after 20 seconds.
Returning Network Settings to Factory Default Settings

If you have forgotten the IP address or the password you can easily return the logger to the default factory settings.

1. Pull out the AC adaptor plug from the RTR-5W logger.
2. Press in the <RESET> button on the RTR-5W logger with a pointed object and reconnect the AC adaptor.

3. When the <Power> lamp on the face of the RTR-5W logger starts blinking, release the <RESET> button and the unit will have been returned to the factory default settings.
3. RTR-61 Registration

This application is designed to carry out Base Unit (RTR-5W / RTR-50), Repeater (RTR-50) and Remote Unit (RTR-61) Registration.
**Base Unit**
When using an RTR-50 as a Base Unit, only one unit can be registered to one computer. When using an RTR-5W as a Base Unit, multiple numbers of units can be registered to one computer.

**About Repeaters**
A "Repeater" is defined as an RTR-50 Wireless Communication Port that has been registered as a "Repeater" to act as a relay for Wireless Communication between a Base Unit and Remote Units from our RTR-61.

**Image of Registration**

- Once the registration of a Repeater is complete, a Repeater Number will automatically be assigned to each Repeater.
- Also, when carrying out Repeater Registration it is possible to assign a "Relay Route Name" that can be used to make sure that data is transmitted through a multiple number of Repeaters in the specified route.
NOTE:
- It is possible to set up so that more than one Repeater acts as a relay for the same Remote Units. However because wireless communication is carried out in Groups of Remote Units, the same Group will be relayed through different Repeaters causing inefficiency and an increase in the amount of communication time to more than necessary. In order to reduce the communication time, please design Relay Routes so that a particular Group of Remote Units uses the same Repeater(s).
- A Repeater Number will be automatically assigned to Repeaters in the order that they were registered to each Route. Communication among Repeaters will occur in sequence from the one that is closest to the Base Unit. Please keep that in mind when placing the Repeaters.

EX: Correct Communication Order
Communication will occur sequentially from the first Repeater as shown below.

EX: When Repeaters are not placed in numerical sequence order
If the Repeaters are not arranged in numerical sequence from the Base Unit, the communication route will be as seen below. This will cause not only the communication distance to increase but also the communication time to increase to longer than necessary.

* Limitations when using a Repeater
Although it is logically possible to register up to 250 Repeaters in a route, each additional Repeater added to the route will proportionately increase communication time. To download the full amount of data from one Remote Unit without any Repeaters will take about 6 minutes, hence with the addition of each Repeater the amount of necessary communication time will be increased by 6 minutes. If there are 9 units, the necessary time would reach about 60 minutes.
Communication time for an RTR-50 is set to be limited to no longer than 150 minutes. For this reason, if there were 250 Repeaters it would be impossible to download the full data of even one Remote Unit. If it is necessary to download a unit with full data, then it is also necessary to have no more than 20 Repeaters.
For all communications other than downloading, no conflict with the time limitation will occur, even if there are 250 Repeaters present.
# Basic Procedure for Registration

<table>
<thead>
<tr>
<th>1. Base Unit Registration</th>
<th>Making a New Base Unit Registration -&gt; p.55</th>
</tr>
</thead>
<tbody>
<tr>
<td>2. Remote Unit Registration</td>
<td>Register all Remote Units which are planned to be used.</td>
</tr>
<tr>
<td></td>
<td>New Registration -&gt; p.58</td>
</tr>
<tr>
<td>3. Repeater Registration</td>
<td>Repeater Registration -&gt; p.61</td>
</tr>
<tr>
<td></td>
<td>However, if communication cannot be successfully carried out due to poor radio wave reception, please add Repeater(s) between Remote Unit(s) and Base Unit.</td>
</tr>
<tr>
<td>4. Wireless Communication Test / Checking Network Connection</td>
<td>Wireless Communication Test -&gt; p.71</td>
</tr>
<tr>
<td></td>
<td>Checking Network Connection -&gt; p.72</td>
</tr>
<tr>
<td>5. Others</td>
<td>Confirming Remote Unit Info, Deleting /Initializing Remote Unit -&gt; p.65</td>
</tr>
<tr>
<td></td>
<td>Confirming Repeater Info, Deleting /Initializing Repeater -&gt; p.67</td>
</tr>
</tbody>
</table>
Making a New Base Unit Registration

From the list of programs in the Window's Start Menu, click on [RTR-61 for Windows(US)] - [RTR-61 Registration] to open the registration window.

Basic Procedure for Registration: from the [Registration] Menu

Connect the unit to be registered to your computer. Then carry out the following procedure to register one Base Unit at a time.

1. Select [Base Unit Registration] in the [Registration] Menu and then select the unit type you wish to register to display the Base Unit registration window.

[Name]
Enter the Base Unit Name.

[IP Address / Domain ] (for RTR-5W only)
Enter the IP Address / Domain that were assigned when making the network initialization settings.

[Http port] (for RTR-5W only)
Enter the HTTP Port Number that was assigned when making the network initialization settings.
[Note]
If necessary, it is possible to write a note such as the Location Name to which the Base Unit belongs.

2. After registration has been completed, a list of all registered Base Units will be displayed.

Base Unit Registration List

Modifying and Deleting Registration Contents: from the [Registration] Menu
Select the Base Unit of which you wish to make modifications to the registration contents of which you wish to delete and then open the [Registration] Menu.

[Modify]
Select the Base Unit from the Base Unit Registration List and then click [Modify] in the [Registration] Menu to display the window in which you can make modifications to the settings.

[Delete]
Select the Base Unit from the Base Unit Registration List and then click [Delete] in the [Registration] Menu. Then a confirmation massage will appear. By clicking the [OK] button, the selected Base Unit will be deleted from the Registration List.
Remote Unit Registration

About Optical Communication with Remote Units
When using Optical Communication to make Remote Unit Registrations please follow the below instructions.

1. Place the supplied Optical Communication Adaptor (RTR-06A1) on top of a registered Base Unit.
2. The "RTR-61 Registration" application open.
3. Place the Remote Unit on top of the adaptor as shown in the figure, making sure that the optical communication area is aligned properly.

For RTR-50

Optical Communication Area

Optical Communication Adaptor (RTR-06A1)

Registered Base Unit : RTR-50

For RTR-5W

Optical Communication Area

Optical Communication Adaptor (RTR-06A1)

Registered Base Unit : RTR-5W
New Registration

When carrying out Remote Unit Registration, see the following procedures to register one Remote Unit at a time. The registration procedures are the same for both unit types, RTR-50 and RTR-5W.

1. Select the Base Unit from the Base Unit Registration List and then open the [Registration] Menu.

2. Select [Remote Unit / Repeater Registration] to display the registration window.

3. Connect the Base Unit which displays its icon to your computer. Then place the Remote Unit (RTR-61 Data Logger) on top of the Base Unit using an optical communication adaptor (See page 57 ).
4. Click on the [Remote Unit Registration] Tab and enter the Group Name / Remote Unit Name. Also, if necessary, set the Communication Frequency Channel.

5. Click the [New Registration] button to start communication with the Remote Unit.

6. When successful communication has occurred, the registered Remote Unit will be displayed in the registration list at the left side of the Main Window.

[Group Name / Unit Name]
Up to 8 characters can be entered for Group Name / Remote Unit Name.
- A distinction will be made between upper and lower case alphabet. Ex. abc123 and ABC123 will be treated as different.
- In order to register a Remote Unit, it is also necessary to register a Group Name.
**[Com. Freq. Ch.] (Communication Frequency Channel)**

It is possible to set one Communication Frequency Channel (channel 0 to 21) to each Group.
- We recommend that a different channel number be assigned for the "Frequency Channel" used for a Group of Remote Units and the "Relay Route Frequency Channel". It will help save the Battery Life of a Remote Unit / Repeater.
- If no setting is made, an unused frequency channel will automatically be assigned. If there are no unused frequency channels, the channel that is used the least shall be automatically assigned.
- Communication Frequency Channel settings can only be made when registering a new Group. Once a Communication Frequency Channel setting has been made it cannot be changed.

**[Relay Route]**

If the distance between a Base Unit and Remote Unit(s) exceeds the possible range of wireless communication, it is possible to set up one or, if necessary, multiple RTR-50 unit(s) as Repeater(s) between them in order to route wireless communication from the Base Station to the Remote Unit(s).

When wishing to communicate via Repeater(s), place a check in the checkbox and select the desired Relay Route Name.
- Up to 250 Relay Routes can be registered. It is not possible to register two Routes with the same name.
- Choose a Relay Route name of eight letters or less.

**[Repeater No.]**

When wishing to communicate via Repeater(s), place a check in the checkbox and select the desired Repeater Number.

**[Get Settings] Button**

Clicking this button will receive the Registration Info for already registered Remote Units (current settings).

Place the Remote Unit (data logger) for which you wish to receive settings face down on top of the Base Unit and click the [Get Settings] button.

When successful communication has occurred, the Group Name and Remote Unit Name will appear.

If you wish to register the currently displayed Remote Registration Contents without any changes, click the [New Registration] button to add the received registration info.
Repeater Registration

1. Connect the Repeater you wish to register to your computer with a USB Cable.

2. Click the [Repeater] tab and enter a Relay Route Name. If necessary, please make a Memo entry and set the Communication Frequency Channel.

3. Then click the [New Registration] button.

4. When successful communication has occurred, the registered Repeater will be displayed in the Registration List at the left side of the Main Window.

[Com. Freq. Ch.] (Communication Frequency Channel)
It is possible to set one Communication Frequency Channel (channel 0 to 21) to each Group. (See page 60 for details)

[Memo]
It is helpful to make a memo entry here in order to distinguish between Repeaters.
- Up to 8 characters can be entered.
- You may leave this field blank if not necessary and should note that changes cannot be made after registering a Repeater. If you wish to make changes, it is necessary to create the Relay Route again.
Registration List

Displays the entire registration (connection) setup for all Units (Base Unit, Repeaters and Remote Units).

Ex. of a [Registration List] display

The registered Relay Route and Group will appear in different background colors so as to be easily distinguishable.
- Gray --------- Shows Base Unit
- Blue --------- Shows Repeaters
- Purple ------- Shows Remote Units which do not communicate via any Repeaters for each Group

The registration (connection) setup of the above example is as follows:

1. The following Remote Units communicate via Repeater Number 1 in Relay Route "Route1".
   - Group1 / Remote1
   - Group1 / Remote2
   - Test / KOKI1

2. The Repeater in Relay Route "Route2" is not connected to any Remote Units.

3. The following Remote Units communicate directly with the Base Unit.
   - Group1 / R1a
   - Group1 / Remote34
   - Group2 / Remote1
Connecting a Remote Unit via Repeater(s)

1. From the Registration List, select the Remote Unit which you wish to connect to the Base Unit via Repeater. Then drag the Remote Unit to the Repeater to which you wish to connect and drop it.

   ![Diagram]

   : Click and drag a Remote Unit and drop it to a Repeater. If the cursor is pointed to an appropriate position, the Remote Unit icon will appear.

   : When dropping a Remote Unit to a Repeater, if the cursor is pointed to an inappropriate position, this sign will appear that indicates you cannot drag and drop it there.

2. The Remote Unit will be added under the location in the Relay Route (background color: blue) in the Registration List.

   ![Diagram]
Removing a Remote Unit from a Relay Route
There are two ways to remove a Remote Unit from a Relay Route and return the location of the Remote Unit just under a Base Unit in the Registration List (background color: light purple).

Select the Remote Unit which you wish to remove from the Relay Route. Then drag the Remote Unit to the Base Unit icon and drop it.

Select the Remote Unit which you wish to remove from the Repeater and right click on it. Then a popup menu will appear. Click on the [No Relay] button.

Selecting Menu in Registration List
By selecting a Remote Unit or a Repeater in the Registration List and right clicking on it, the Menu will be displayed.

The Tab window at the right will automatically be changed according to the selected Menu item.
Confirming Remote Unit Info, Deleting / Initializing Remote Unit

Confirming Remote Unit Info
The Remote Unit info selected in the registration list will be displayed.

Deleting Remote Unit / Group

[Delete Remote Unit] Button
Deletes the Remote Unit in the current display from the Remote Unit Group List and Registration List.
- The deleted Remote Unit will no longer be able to carry out wireless communication with the Base Unit connected to the computer.
- By deleting a Remote Unit, communication will be impossible with that unit. However, the registration contents will still remain in the unit. Make sure to initialize it when not in use.
- The Relay Route and Repeater in the current display will not be deleted.
[Delete Group] Button
Deletes the Group in the current display from the Remote Unit Group List and Registration List. When a Group is deleted, wireless communication will not occur with all Remote Units belonging to that group.
- By deleting a Group, communication will be impossible with all units registered to that group. However, the registration contents will still remain in the unit. Make sure to initialize it when not in use.
- The Relay Route and Repeater in the current display will not be deleted.

Initializing Remote Unit
Initializes the Remote Unit Registration Contents via optical communication with the Remote Unit. After initializing a Remote Unit, the Unit will be returned to its original default settings, as shown below.

Group Name: GROUP1
Com. Freq. Ch: 0
Remote Unit Name: Sr001

1. Place the Remote Unit that you wish to initialize on top of the Base Unit connected to your computer.
   - See page 57.
2. Click the [Initialize] button on [Remote Unit Info / Delete / Initialize] Tab.

   - When initializing a currently registered Remote Unit, the Registration Info will also be erased from the Registration List.
Confirming Repeater Info, Deleting / Initializing Repeater

**Confirming Repeater Info**
The Repeater Info selected in the Registration List will be displayed.

**Deleting Route / Repeater**

**[Delete Route] Button**
Deletes the Relay Route in the current display from the Remote Unit Group List and Registration List. When deleting a Relay Route, all Repeaters which belong to that Relay Route will also be automatically deleted.
[Delete Repeater] Button
Deletes the last Repeater in the Relay Route listed in the current display from the Remote Unit Group List and Registration List; only the last unit can be deleted.
- Any Repeater other than the last one in the Route cannot be deleted.
- If you wish to delete Repeater(s) other than the last one in the Route, it is necessary to either delete each Repeater in sequence from the last to the one(s) you wish to delete, or delete the entire Relay Route itself (as above in "Delete Route") and register Repeaters to design a Route again.

Replacing Repeater
1. Connect the one you wish to newly register to your computer with a USB Communication Cable.
2. Click the [Replace Unit] button. The newly replaced Repeater will be registered with exactly the same registration contents as the old one.

- If you wish to replace a Repeater with a new one due to malfunction or trouble without changing the Route design, connect the new Repeater to the computer and click this button.
- After having replaced a Repeater with a new one, the registration info remains in the Repeater that you had been using. Make sure to initialize it or remove the batteries when not in use.
- All Remote Units that were registered for communication via the Repeater that is to be replaced will be automatically connected to the Base Unit for communication. If you wish to communicate with the Remote Units via the newly added Repeater, it is necessary to manually move them in the Registration List so they connected for communication via the new unit.
Initializing Repeater (Returning to Base Unit)

1. Connect the Repeater you wish to initialize to your computer with a USB Communication Cable.

2. Select the [Repeater Info / Delete / Initialize] tab and click the [Initialize] button.

   Initializing the Unit will return it to the condition it was in when it left the factory. The default setting for an RTR-50 Unit is as a Base Unit. When using as a Base Unit from the start, initialization is not necessary.
Getting Base Unit / Repeater Info (Direct Communication)

It is possible to view the Repeater or Base Unit Registration Info.

1. With a USB Communication Cable, connect the Repeater or Base Unit you wish to view the Registration Info to your computer.

2. Select the [Get Base / Repeater Info (Direct)] tab and click the [Get Unit Info] button.

3. The communication results will appear.

[Result]
Displays whether the connected unit has been registered as a "Base Unit" or "Repeater:"

-For a Repeater
Displays the name of the Relay Route, Frequency Channel, Repeater No. and Battery Level for the Repeater.

-For a Base Unit
Displays Battery Level for the Base Unit.

RTR-50 Battery life and Battery Replacement
The Battery Level will be shown in 5 stages (1 to 5).

We suggest that you change the batteries if the remaining battery level becomes 3 or lower. (1: Low < 5: High)
Wireless Communication Test

If Placing Repeater(s)
After completing Remote Unit / Repeater Registration, please carry out the Wireless communication test to check the Communication Status.

- A test for Remote Units which communicate directly with the Base Unit (no Repeaters) cannot be carried out here.

1. In the [Remote / Repeater Registration] window, click the [Wireless Communication Test] from the [Communication] Menu.

2. Select the test method you wish to use for testing wireless communication and then click the [Start Communication] button.

Test All Remote / Repeaters
The Radio Wave Strength will be shown in the communication results for all Remote and Repeaters which are displayed in the Registration List.

Remote Unit Group
The Radio Wave Strength for the Remote Units which belong to the Group selected from the Remote Group Name List will be displayed.

Relay Route
If you have checked [Selected Route], please select the Relay Route for which you wish to carry out the Radio Wave Strength Test from the Relay Route Name List. If you have checked [All Routes] in the [Select Route for Test] box, the Radio Wave Strength Test for all Relay and Remote Units that belong to each of the Routes will be carried out.
### Wireless Communication Test Results

- **Communication Successful**
  The number of vertical lines shows the Radio Wave Strength.
  (1: Weak < 5: Strong)

- **Communication Failure**
  Appears in front of the Remote or Repeater Name for which a communication failure has occurred.
  - Note that a communication error may occur depending on the wireless communication environment or condition. If wireless communication continually results in failure, there may be the Weak Radio Wave or Low Battery Level. Please check the Base, Relay and/or Remote Unit location.

- **Appears in front of the Remote or Repeater Name for which the test has not been selected in the test mode (communication does not occur).**

### Checking Network Connection

Open Internet Explorer. Then enter the IP address (or Domain Name) that has been assigned to the RTR-5W in your browser's URL bar. If proper settings have been made with a correct IP address, the following message will be displayed.

```
Address: http://192.168.23.65/  
Web Wing WL RTR-5W  
(Thermo Recorder Push Wireless Mode)
```
About [File] Menu

[Open Remote Registration File...] Opens the Remote Registration File.

[Save Registration File As...] Assigns a name and saves the currently displayed Remote Unit Information to a new Remote Registration File.
- In this file the data is stored in binary format.
- You cannot edit the contents of the Registration File once it has been saved.
- Normally, there is no need to save a Remote Registration File. The current registration information is saved in the computer and on the next boot, this information will automatically be loaded. This file can be used, however, for copying registration information from one computer to another, or for changing registration on the current computer.

[Quit] Quits and closes the application.
4. How to use "RTR-61 for Windows"

After completing the Remote Unit Registration, open the settings application "RTR-61 for Windows" to make various operational settings for the Remote Unit(s).
About the Display

Main Window

Menu Bar
The Menu commands are lined up as [File], [View], [Communication] and [Help].

Remote Unit List
All registered Remote Units will be listed here. Select a Base Unit when using optical communication and select a Remote Unit when using wireless communication. Then go to the [Communication] Menu to carry out the necessary commands.

Communication Log
A log listing communications with Remote Units while the application is running will be displayed. (See the next page.)
Communication Log

When communication is carried out with a Remote Unit, the communication log will appear at the right side of the Main Window. The Date/Time of operation, the Base Unit, the Group and Remote Unit Name, Communication Contents, Result and Notes will be shown.

If Communication Fails

If a communication error occurs with a Remote Unit, the message "Failure" will appear in the [Result] column. In such a case, see [Troubleshooting] or the explanations in the application's Help Menu.

Full Communication History [File Name: com.log]

While the communication log for communications which occurred while the application was running are shown in the Main Window, a file containing "Full Communication History" will be automatically stored in the same folder where "RTR-61 for Windows (US)" was installed. (See page 130 for details)
Item Table: [File] Menu

Use this to create Item Tables and register them into Remote Units via wireless communication. Up to 62 Items can be registered to one Remote Unit. Also, use this menu to make Upper / Lower Limit settings.

Displaying [Item Table] Window

Please open the "Item Table" in the following way:

1. Select one or a multiple number of Remote Units from the Remote Unit List and open the [File] Menu.
2. Also by right clicking on the Remote Unit List Display, the Menu will appear.
3. Select a Remote Unit from the Remote Unit List and right clicking.
4. [Item Table] Window

- Item Group List
- Item Name, Upper / Lower Limit
By holding down on the <Shift> key or <Ctrl> key and clicking on another Remote Unit, it is possible to select a multiple number of Remote Units at the same time.

- Note that if more than one Remote Unit has been selected, some commands in the [Communication] Menu cannot be carried out.

Hold down the <Shift> key to select several sets of Remote Units. Hold down the <Ctrl> key to select Remote Units separated from one another.
Creating Item Tables

Item Table Registration is carried out in Groups.

- Up to 62 Items can be entered in each table. However, one Group Name will be treated as one Item. For example, if you wish to create 3 Groups, then, up to 60 items can be registered.
- Up to 12 characters can be entered for Item Group and Item Name.
- The Upper / Lower Limit must be set in a range of 455°F to –13°F (235°C to -25°C)

1. Right click on the Item Group List in the Item Table and select [Insert Group] from the Menu. Then enter the Item Group Name.

2. Place the cursor at the beginning of the desired column and enter the Item Name, Upper Limit and Lower Limit in the Item List.

3. Right click on the Item List and select [Insert Item] from the Menu to add an Item to the Item List.
NOTE:
- In “Communication” Menu – “Operational Settings” (Page 96), you can shift the unit of display between Fahrenheit (F) and Celsius (C). It is also possible to select whether to make upper and lower limit settings in Fahrenheit or in Celsius when receiving Remote Unit Info (Page 105) in “Communication” Menu – “Get Remote Unit Info.”
- If a name that has already been assigned to another Item is entered and/or the number of entered characters exceeds the limit, an error message will appear.
### Sending Item Tables

After making Item Table entries, select [Send Item Table] from the [Communication] Menu to send the entered info to the Remote Unit (RTR-61 data logger). When the communication has been completed, the Item Table will be registered into the Remote Unit.

**NOTE:**

- Note that by carrying out [Send Item Table] all previously recorded data will be deleted from the Remote Unit.

---

**[Communication] Menu**

- If you wish to use the same settings for a number of Remote Units, select a multiple number of Remote Units and send the Item Table. All selected Remotes will be given the same Item Table settings.

---

**[Item Table ID]**

In the [Note] column on the communication log display, the Numbers starting with "ID" may be displayed. These Numbers are Identification ID which will be automatically assigned by the application when communication with a Remote Unit is carried out. Whenever an Item Table has been successfully sent, the assigned ID Number will be displayed.
Getting Item Tables
To get an Item Table from a Remote Unit, select one Remote Unit from the Remote Unit List and click [Get Item Table] in the [Communication] Menu of the [Item Table] window.

NOTE:
- The getting of an Item Table cannot be carried out on a multiple number of Remote Units.

Inserting / Deleting / Correcting Item Tables
1. Place a check next to [Permit corrections to Item Table].

2. Select the Item line to be corrected and right click on it to show the Menu.

[Insert Item]
It is possible to add a new Item above the selected line.

[Delete Item]
It is possible to erase the selected line.
3. Select the Item line you wish to correct and move cursor to the desired position for each column "Item Name", "Upper Limit" and "Lower Limit", click that position to make any necessary corrections.

![Image of Item Name, Upper Limit, Lower Limit]

**NOTE:**
- In "Communication" Menu – "Operational Settings" (Page 96), you can shift the unit of display between Fahrenheit (F) and Celsius (C). It is also possible to select whether to make upper and lower limit settings in Fahrenheit or in Celsius when receiving Remote Unit Info (Page 105) in "Communication" Menu – "Get Remote Unit Info".
- If a name that has already been assigned to another Item is entered and/or the number of entered characters exceeds the limit, an error message will appear.

![Image of error messages]
Deleting the Contents of an Item Table
By selecting [Create New] in the [File] Menu, all Items that are displayed in the Item Table will be deleted.

- The deletion made here will not be reflected in the RTR-61 Remote Unit until the [Send Item Table] command in the [Communication] Menu is executed.

Saving Item Tables in Text File / Reading Text File Formatted Item Tables
By clicking [Export Text] in the [File] Menu, the Item Table contents can be saved in Text File Format.

By clicking [Import Text] in the [File] Menu, it is possible to read the file saved in Text File Format and display the data in an Item Table.

- It is also possible to create an Item / Upper Limit / Lower Limit data list in the same Text File Format as when the data was exported.
Other Menus

Remote Measurement Command: [Communication] Menu
This command will send Measurement Command to the Remote Unit and according to user directions will gather recorded data.
- For details about Remote Measurement Commands see page 108.

- Remote Measurement Command cannot be carried out when a multiple number of Remote Units has been selected.

Close: [File] Menu
Closes the Item Table Window.
User Table: [File] Menu

Use this to create User Tables and register them into Remote Units via wireless communication. Up to 61 Users can be registered to one Remote Unit.

Displaying [User Table] Window

Please open the "User Table" in the following way:

Select one or a multiple number of Remote Units from the Remote Unit List and open the [File] Menu.

Also by right clicking on the Remote Unit List Display, the Menu will appear.
By holding down on the <Shift> key or <Ctrl> key and clicking on another Remote Unit, it is possible to select a multiple number of Remote Units at the same time.

- Note that if more than one Remote Unit has been selected, some commands in the [Communication] Menu cannot be carried out.

Hold down the <Shift> key to select several sets of Remote Units.  
Hold down the <Ctrl> key to select Remote Units separated from one another.

■Creating User Tables

User Table Registration is carried out in Groups.

- Up to 61 Users can be entered in each table. However, one Group Name will be treated as two Users. For example, if you wish to create 3 Groups, then, up to 57 Users can be registered.

- Up to 8 characters can be entered for User Group and User Name.

1. Right click on the User Group List in the User Table and select [Insert Group] from the Menu. Then enter the User Group Name.
2. Place the cursor at the beginning of the desired column and enter the User Name in the User List.

3. Right click on the User List and select [Insert User] from the Menu to add an User to the User List.

**NOTE:**

- If a name that has already been assigned to another User is entered and/or the number of entered characters exceeds the limit, an error message will appear.
Sending User Tables

After making User Table entries, select [Send User Table] from the [Communication] Menu to send the entered info to the Remote Unit (RTR-61 data logger). When the communication has been completed, the User Table will be registered into the Remote Unit.

**NOTE:**
- Note that by carrying out [Send User Table] all previously recorded data will be deleted from the Remote Unit.

[Communication] Menu

- If you wish to use the same settings for a number of Remote Units, select a multiple number of Remote Units and send the User Table. All selected Remotes will be given the same User Table settings.

[User Table ID]

In the [Note] column on the communication log display, the Numbers starting with "ID" may be displayed. These Numbers are Identification ID which will be automatically assigned by the application when communication with a Remote Unit is carried out. Whenever a User Table has been successfully sent, the assigned ID Number will be displayed.
Getting User Tables
To get a User Table from a Remote Unit, select one Remote Unit from the Remote Unit List and click [Get User Table] in the [Communication] Menu of the [User Table] window.

![Communication] Menu

Select one Remote Unit

NOTE:
- The getting of a User Table cannot be carried out on a multiple number of Remote Units.

Inserting / Deleting / Correcting User Tables
1. Place a check next to [Permit corrections to User Table].

![Check here]

2. Select the User line to be corrected and right click on it to show the Menu.

![Insert User]

[Insert User]
It is possible to add a new User above the selected line.

[Delete User]
It is possible to erase the selected line.
3. Select the User line you wish to correct and move cursor to the desired position for each column "User," click that position to make any necessary corrections.

![User Table]

**NOTE:**
- If a name that has already been assigned to another User is entered and/or the number of entered characters exceeds the limit, an error message will appear.

![Error Messages]

- **Deleting Contents of User Tables**
  By selecting [Create New] in the [File] Menu, all Users that are displayed in the User Table will be deleted.
  - The deletion made here will not be reflected in the RTR-61 Remote Unit until the [Send User Table] command in the [Communication] Menu is executed.
■ Saving User Tables in Text File / Reading Text File Formatted User Tables

By clicking [Export Text] in the [File] Menu, the User Table contents can be saved in Text File Format.

By clicking [Import Text] in the [File] Menu, it is possible to read the file saved in Text File Format and display the data in a User Table.

- It is also possible to create a User data list in the same Text File Format as when the data was exported.

■ Other Menus

Close: [File] Menu
Closes the User Table Window.
[Communication] Menu

Use the [Communication] Menu to make Remote Unit operational settings and download recorded data. Menus differ depending on the type of communication: wireless or optical.

- WL: Menus for Wireless Communication
- OPT: Menus for Optical Communication

Selecting the [Communication] Menu for Wireless Communication
Select the desired menu by following directions as below.

Select the Remote Unit(s) with which you wish to communicate from the Remote Unit List and then open the [Communication] Menu.

Also by right clicking on the selected Remote Unit(s), the Menu will be displayed.
By holding down on the <Shift> key or <Ctrl> key and clicking on another Remote Unit, it is possible to select a multiple number of Remote Units at the same time.

- Note that if more than one Remote Unit has been selected, some commands in the [Communication] Menu cannot be carried out.

  Hold down the <Shift> key to select several sets of Remote Units. Hold down the <Ctrl> key to select Remote Units apart from one another.

---

**Selecting the [Communication] Menu for Optical Communication**

1. Place the supplied Optical Communication Adaptor (RTR-06A1) on top of a registered Base Unit.

2. Place the Remote Unit on top of the adaptor as shown in the figure, making sure that the optical communication area are aligned properly.

3. Select the icon of the Base Unit and then click [Communication] or right click on the icon to display the Menu available for optical communication.
NOTE:
- If you have made changes to the recording mode and sent the settings to the Remote Unit, all previously recorded data will be erased from the Remote Unit.

Open the [Operational Settings] Window

1. Select a Remote Unit from the Remote Unit List.
2. From the [Communication] Menu, select [Operational Settings].

Making Settings in the [Required Settings to Send] Area

1. By clicking the [Get] button, it is possible to obtain the current settings for the selected Remote Unit.
   - The getting of current settings cannot be carried out on a multiple number of Remote Units.
   - Because some settings can be made in the Remote Unit from the RTR-61 Unit itself, it may occur that the setting info in the computer and the actual settings written into the Remote Unit are different.
   - For details about the settings and operations that can be carried out by the RTR-61 Unit, see the User’s Manual that accompanies your Push Wireless RTR-61 data logger.
2. Make settings for the items in the [Required Settings to Send] area.
   - Changes cannot be made to the settings for some items if a multiple number of Remote Units has been selected.

3. Click the [Send] button to start communication with the Remote Unit and the settings will be transmitted.
   - The settings made here will not be reflected in the RTR-61 Remote Unit until the [Send] button is clicked and communication can occur with the Remote Unit.

[Recording Mode]

Endless : When the RTR-61 data capacity is FULL, the oldest data is overwritten and recording continues.

One-Time : When the RTR-61 data recording capacity is FULL, recording stops and no more new data can be recorded.

Remote : Controls the "PUSH Recording" function of an RTR-61 data logger from a remote site. When an RTR-61 unit has been set to "Remote Mode", it is possible to carry out a PUSH recording only when the Management Operator sends a Measurement Command to the data logger via wireless communication.
   - For details about Remote Measurement Commands see page 108.

[Unit of Temp]
Select the desired unit of temp (C or F) for the RTR-61 measurement display.

[Judgment LED]
Make Judgment LED settings for the Remote Unit.

ON : If a set upper or lower limit has been exceeded while measuring temperature, the Judgment LED will blink in RED.

OFF : Even if a set upper or lower limit has been exceeded while measuring temperature, the Judgment LED will NOT blink.

[Button Sound]
Make settings for the sound when operating the buttons.

ON : Turns ON the beep which sounds when pressing a button on the RTR-61 unit.

OFF : Turns OFF the beep sound.
[Backlight]
Make settings for the Backlight for lighting the LCD display of the Remote Unit.

**Always ON** : The backlight of the Remote LCD display will always be ON regardless of whether in operation or not.

**Always OFF** : The Backlight of the Remote LCD display will always be OFF regardless of whether in operation or not.

**ON in Use** : Only when operating the Remote Unit, the LCD display will be lit up for 3 seconds.

[Button Lock ]
To help prevent changes being made to the settings, this function enables restrictions to be placed on the ability of users to use buttons on the Remote Unit.

**ON** : Only the <REC>, <ON/OFF> and <ENT> buttons are operable.

**OFF** : All users are permitted to carry out any direct operations on the RTR-61 Unit.
- The <ENT> button is operable only while a Message is being displayed (see page 107) or a Measurement Command is received (page 108) from the Management Operator.

[Wait for Constant Temp Settings]
Please set the temperature change value for allowable temperature change within one second (Delta Temperature: °F /sec) between 0.2 °F and 45.0 °F.
When the <REC> button on the RTR-61 Unit has been pushed and a change in temperature occurs within a second which is greater than that which was set as the allowable temperature change (Delta Temperature: °F /sec) value, the temperature will not be recorded until temperature stabilization has been achieved. If, after 15 seconds, the temperature does not stabilize, recording will not be performed.
- If the "Wait for Constant Temp Settings" has been set to "ON" and the value which has been set for the temperature change falls outside the 0.2°F to 45.0 °F range, the [Send] button will be inoperable.
[Select Item / Select User]
The specified item and user name will be displayed in the Top Window of the Remote Unit. By clicking the [ ] button, select the desired Item and Name from the list box (Group Name / Item Name / User Name).

Item and User Names which have been registered in the Remote Unit can be selected.

The Upper / Lower Limit Values for the selected Item will be displayed.

- If the Item Table and User Table have not been gathered from the Remote Unit by using the [Get] button, the list box will be left blank.
- If this list is blank, the Item / User Name which are at the beginning of the list in the Remote Unit display will be selected.
- If more than one Remote Unit has been selected, the Item / User Name Table settings cannot be made.
- In this case, the Item / User Name which are at the beginning of the list in the Remote Unit display will automatically be selected.
Making Recorded Data File Settings
Here it is possible to assign a file name and location to which the recorded data will be saved after downloading it from a Remote Unit via wireless communication.

1. Make settings for the items in the [Recorded Data File Settings] area.
   - If a multiple number of Remote Units are selected, changes cannot be made to the settings in the [Prefix] column.

2. By clicking the [Apply] button, the same settings made here will be applied to all selected Remote Units.
   - If the Window is closed without clicking the [Apply] button, the settings made here will not be applied.

[Recorded Data File Settings] area

[Prefix]
Assign a file name to save the data which has been downloaded via wireless communication. If the Prefix setting has not been made, a file name will be automatically assigned using the following format, "Group Name_Remote Unit Name_Date / Time_ext". It is possible to make changes to the Group Name and Remote Unit Name.
   - If a multiple number of Remote Units is selected, the Prefix setting cannot be made.

[Location]
By clicking the [ ... ] button, it is possible to select the desired folder. The data downloaded via wireless communication will be saved into the specified folder.
RTR-61 Clock Settings

Make Remote Unit clock settings here.

1. Select one Remote Unit from the Remote Unit List.
2. From the [Communication] Menu, select [Clock Settings].
3. Check [Set to Computer Clock] or [Set to Specified Time].
4. Click the [Send] button to start communication with the Remote Unit.

NOTE:
- After making clock settings, please erase the recorded data in the Remote Unit. When downloading recorded data by specifying date and time, it may not work properly.
### Downloading Recorded Data

Here it is possible to download recorded data from Remote Units to a computer.

1. From the Remote Unit List, select one Remote Unit or multiple Units from which you wish to download data. If you wish to download data via optical communication, select a Base Unit.
   - See page 55 for details about optical communication with Remote Units.
2. In the [Communication] Menu, click [Download Data].
3. Check and assign a file name and location.
   - If you wish to temporarily change a file name and/or location, see next page for details.
4. Select the Download Range and click the [Download] button to start communication.

#### Selecting the Download Range

Select whether to download all recorded data or to download only part of the data recorded after a specified time.

- **All Data**: Download all recorded data from the Remote Unit.
- **Specify Data by Time**: Download only that data recorded after a specified time.

**NOTE:**
- After making clock settings (see page 101), make sure to erase the recorded data in the Remote Unit. Otherwise it may not work properly when downloading data by specified time.
About File Names and Locations for Downloaded Data

There are two ways to specify a file name and destination folder in which to save the downloaded data.

Click to make temporary settings for the file name and / or destination folder.

Click on the file name and/or the destination folder to make any temporary changes to the name or folder. By closing the [Download Data] Window, the settings made here will be used.

Select the Remote Unit you wish to make settings for. Then place the cursor at the file name or destination folder and click on it to make changes.

Make settings from [Operational Settings]

Prefix and destination folder settings can be made from the [Operational Settings] Menu – [Recorded Data File Settings]. (See page 100 for details)

A Data File Name will be automatically assigned with the following format.

**Data Downloaded via Wireless Communication:**

[Group Name_Remote Unit Name_M/D/Y/Hr/Min/Sec.Ext]

- Changes can be made to the prefix ([Group Name_Remote Unit Name]) in the Operational Settings Window under "Recorded Data File Settings" - "Prefix".

**Data Downloaded via Optical Communication:**

[M/D/Y/Hr/Min/Sec.Ext]

About Downloaded Data Files

When downloading recorded data, data file ".puw" and text file ".txt" will be simultaneously created and saved into the same destination folder.

- For details about the destination folder, see page 128 for details.
■ Checking Downloaded Data
By clicking the [View Data List] button after downloading data, the "RTR-61 Data Viewer" will be opened. Here it is possible to view the downloaded data as a list.

- For details about "RTR-61 Data Viewer", see page from 117.

When downloading data via optical communication or by one Remote Unit at a time
After downloading has been completed, the [View Data List] button will become active. By clicking this button, the "RTR-61 Data Viewer" will be opened and the downloaded data can be viewed as a list.

When downloading data by selecting a multiple number of Remote Units
By selecting one set of data to view, the [View Data List] button will become active. By clicking this button, the "RTR-61 Data Viewer" will be opened and the selected data can be viewed as a list.
Getting Remote Unit Info

It is possible to gather the settings info from Remote Units.

1. From the Remote Unit List, select one Remote Unit from which you wish to download data. If you wish to download data via optical communication, select a Base Unit.
   - See page 57 for details about optical communication with Remote Units.
2. From the [Communication] Menu, select [Get Remote Unit Info].
3. Click the [Get] button to start communication with the Remote Unit.

   Select a Base Unit (Optical) or a Remote Unit (Wireless)

4. After the communication has been completed, the Remote Unit settings info will be displayed.
   - About the display before getting the current info: Because some settings can be made in the Remote Unit from the RTR-61 Unit itself, it may happen that the settings info in the computer and the settings written into the Remote Unit are different.
Erasing Recorded Data

Please erase the recorded data in the Remote Unit as desired.

1. Select one Remote Unit or multiple Remote Units from the Remote Unit List.

2. From the [Communication] Menu, select [Erase Recorded Data].

3. Click the [Send] button to start communication with the Remote Unit(s) and the recorded data in the selected Remote Unit(s) will be erased.

   - If the Dialog Box is closed without clicking the [Send] button, the data in the Remote Unit will not be erased.

\[NOTE:\]

Upon execution of the following menus under [Communication], the recorded data in the Remote Unit will be erased.
- Send Item Table
- Send User Table
- Send Operational Settings (When making changes to the recording mode)
- Erase Recorded Data

We suggest periodic downloading and saving of recorded data to the computer.
Sending Messages

It is possible to send any message you create to a Remote Unit. Note that there is no reply function from the Remote, nor any message storing function in the Remote Unit.

1. Select one Remote Unit or multiple Remote Units from the Remote Unit List.

2. In the [Communication] Menu, click [Send Message].

3. A four-line message can be sent. Up to 18 letters can be entered in each line.
   - If the number of entered letters exceeds the limit, the message cannot be sent.
   - It is possible to move a text type file to the [Send Message] Window by simply using drag and drop.

4. Place a check mark next to the desired method of notification for when a message arrives.
   - Regardless of operational settings made for the Remote Unit(s), the setting made here (LCD backlight or beeping sound) will notify users when a message arrives.

5. Click the [Send] button to send the message to the Remote Unit.
   - If the Window is closed without clicking the [Send] button, the entered message will not be sent.

[Diagram showing how to send messages]
Remote Measurement Commands

This menu will send a Measurement Command to a Remote Unit and download the data recorded from the Remote Unit by following user orders.

1. From the Remote Unit List, select one Remote Unit for which the "Item Table" has already been gathered.

2. In the [Communication] Menu, click [Remote Measurement Command].

3. Select the Measurement Item and make the communication condition settings.

[Measurement Command Time-out ]
This is the amount of time for a timeout and a judgment to be made from when a Measurement Command has been made to a Remote Unit.

[Interval for Gathering Remote Status]
During the period of time which has been set as the Measurement Command timeout, this interval is the amount of time between communications with the Remote Unit to check on its status, i.e. whether the measurement /recording request has been completed or not.
4. Click the [Send Command] button to send the message to the Remote Unit and wait for the response from the Remote Unit.

- If the Window is closed without clicking the [Send Command] button, the Measurement Command will not be sent.
- If the Recording Mode in the Remote Unit has not been set to "Remote" such Remote Measurement Commands cannot be made.
- If no Item Table has been registered into the Remote Unit, Remote Measurement Commands cannot be carried out.
- Depending on the setting, the Unit of Temperature for display will be shifted between °C and °F.
- Remote Measurement Commands cannot be carried out on a multiple number of Remote Units.

Messages shown during communication of a Measurement Command

By clicking [Send Command], a message will appear that a communication is currently in progress.

![Communicating with XX.]

When an RTR-61 unit receives a Measurement Command, the message displayed during communication will change.

![Waiting for Remote Measurement Results.]

The results of the remote measurement will be waited for during the time period set in [Measurement Command Timeout].
Communication Results
When a measurement and recording is carried out before the set Measurement Command Timeout period expires, the communication result will be shown in the [Result] column of the [Communication Log] Window.

- **[Success]**
  Remote measuring and recording was successful during the time period

- **[Failure]**
  Remote measuring and recording failed or was not carried out within the time period
■ Checking Data
After the Remote Measurement Command communications are completed, it is possible to view the recorded data.

[Communication Log] Window - [Note] Column
It is possible to check the data recorded by a Remote Measurement Command.

[View Data List] Button
This will open the "RTR-61 Data Viewer". It is possible to view all data recorded by a Remote Measurement Command.
Data Files Recorded by Remote Measurement Command

The data measured and recorded by a Measurement Command will be automatically saved into a file entitled "RemoteRec.puw" in the same folder where "RTR-61 for Windows" was installed.

- For details about opening an automatically saved data file, see page 130.
Adjustment Function

Adjustment is a function to adjust for any differences which may occur in measurement values. By entering the adjustment values beforehand, it is possible to view and record the adjusted measurement values. There are two methods of adjustment: [1 Point Adjustment] and [2 Point Adjustment]. Adjustment is based upon the simple equation $Y=aX+b$. ($X$ equals the measured value and $Y$ equals the value after adjustment)

**NOTE**
- We cannot guarantee that after carrying out adjustment the measuring accuracy will improve for all measuring ranges.

1. Prepare the unit to be adjusted for Optical Communication and then select the correct Base Unit from the Remote Unit List.

2. In the [Communication] Menu, click [Adjustment] to open the settings window.

3. Select the adjustment method and enter values for "Current Reading" and "Post-adjusted Reading".
   - For details about Adjustment Methods see the following page.

4. Place a check next to the desired unit of temperature.

5. Click the [Send] button to transmit the settings to the Remote Unit. A confirmation message will appear; if correct click the [OK] button.
About Adjustment Methods

[1 Point Adjustment]

Use when measuring in a range of ±20°C.
This adjustment method changes only the offset (b) where the slope (a) is considered 1.
For example, RTR-61 is measuring 10°C, but the standard says the actual measurement should be 10.2°C. Enter 10 in the Before Adjustment box and 10.2 in the After Adjustment box. The conversion equation will be Y=X+0.2 and for all measurements an adjustment to the offset of +0.2 will be made.

[2 Point Adjustment]

The adjustment equation will be calculated from two points: the slope (a) and the offset (b).
For example, the RTR-61 reads 0°C when the standard thermometer reads 0.1°C, and RTR-61 reads 10°C when the standard says the true measurement is 10.2°C. In this case the slope (a) is 10.2-0.4/10-0=0.98. The offset is 0.4, so the conversion equation becomes Y=0.98X+0.4. The range of the slope is 0<a<=2. Entries are valid to one decimal point, but after calculation up to four digits are valid for the slope and offset.

- When adjusting at 2 points, it is important to make sure the points are not too close to each other. The probability of measurement errors will increase in other ranges outside of the two points. If possible, select two points apart from one another (we suggest at least 10 degrees) to measure and make the necessary adjustments.
- When adjusting at 2 points, make sure the difference in points is at least 10 degrees.
- When measuring a wide range and adjusting at 2 points, make sure that the adjustment values reflect the wide range you are measuring.
- When adjusting at 2 points, any measurements that fall outside of those points are subject to error.
[Before / After Adjustment]
Enter the actual measurement before adjustment and the desired measurement after adjustment. From these, an adjustment equation will be formulated. However, do not enter values that would result in the slope (a) being 0.

[Unit of Temperature]
Select the desired unit of temperature.

[Send] Button
This will send the settings to the Remote Unit.

[Get] Button
This will communicate with the Remote Unit and gather the current settings.

[Initialize] Button
This clears any previous adjustment equation(s) and initializes the device.

[Close] Button
This closes the Settings Window. If the window is closed before the [Send] button has been clicked, the settings will not be completed.

[Help] Button
This displays the Help Menu.
5. How to Use "RTR-61 Data Viewer"

After downloading recorded data to your computer, the downloaded data can be viewed by using "RTR-61 Data Viewer"
About the Display

Menu Bar
Menu commands: [File], [Edit], [View], [Help]

Data List
When the "Data Viewer" program has read a data file, all recorded data in the file will be listed here.

Remote Unit Info
Here it is possible to check the Info for the Remote Unit which recorded the displayed data.

About File Names

1. Data File Names for Data Downloaded via Optical Communication [M/D/Y/Hr/Min/Sec/.ext]
2. Data File Names for Data Downloaded via Wireless Communication [Group Name_Remote Name_M/D/Y/Hr/Min/Sec/.ext]
3. Data File Names for Data Downloaded by Remote Measurement Command [Remote Rec.puw]
Opening Saved Data

See the following procedures for opening a data file. The data file extension for data recorded by RTR-61 data loggers is ".puw".

Open files from the [File] Menu

1. In the [File] Menu, click [Open].

2. Select the location and name of the data file you wish to open. Then either double click on it or click the [Open] button.

Dragging and Dropping Data Files

Select the location and name of the data file you wish to open. Then drag and drop it to the Data List.
### Uploading Additional Data Files

It is possible to add new data files to the already uploaded file(s) and view several sets of data in one list. If while viewing data in the Data List, another set of data is selected a message will appear to confirm it is OK to upload the newly selected data file.

[Upload New File Confirmation] message

The data numbers will change from the data in the additional data file.

### Remote Unit Info

Upon opening a data file, Remote Unit Info will appear for the Remote at the time when data was downloaded.

When uploading an additional data file, the Remote Unit Info will become blank for contents which are not the same for all Remote Units currently in view.
[File] Menu

Edited data can be saved and/or output into text file format.

**Saving Data**
Data edited in "RTR-61 Data Viewer" can be saved by selecting [Overwrite All Data] or [Save All Data As...] in the [File] Menu. Save by assigning an appropriate file name and location. Master Files cannot be overwritten.

- A Master File is the original data file that was downloaded from a Remote Unit.

**Exporting Text Data**
It is possible to export data in text file format to be read by other applications, such as spreadsheet and editing software. Select [Save Data in Text File] in the [File] Menu to export as text data. Save by assigning an appropriate file name and location.

- The file format is text type (comma delimited) only.
- The extension for the created file will be ".txt".
- Data saved as text file cannot be read by "RTR-61 Data Viewer"
**Print**

Use this to print Data Lists. The [Print] dialog box will appear where you can specify the page(s) for printing, the number of copies you wish to print, and make all settings for printer selection and printing options.

![File Menu](image1.png)

**Print Preview**

An image of what will be printed can be viewed in the Print Preview Display.

![Print Preview Toolbar](image2.png)

The following operations can be done from the Print Preview Display Toolbar:

**[Print] Button**

The [Print] dialog box will appear and printing will begin.

**[Prev] / [Next] Buttons**

Preview the previous or next page.

**[Zoom Out] / [Zoom In] Buttons**

Zoom-in or out on data in the currently displayed page.
[Close] Button
Close the Print Preview display and return to the Main Window.

*About Non-printable Sections
The Data Viewer [Judgment] column will not be printed. If recorded data has exceeded a set upper or lower limit, the letter " U " or " L " will be displayed next to the value of the temperature measurement.

Also, item(s) which were not selected in [View] - [Item View] will not be printed. (See page 125 for details)
[Edit] Menu

Here it is possible to delete selected data.

1. Select the data you wish to delete. To simultaneously delete several sets of data use the <Shift> key or <Ctrl> key to select several sets of data.

   Hold down the <Shift> key to delete several consecutive sets of data.

   Hold down the <Ctrl> key to select non-consecutive Remote Units to delete them.

2. Either go to the [Edit] Menu or right click on one set of data. Then select [Delete Line of Choice] to delete the desired data.
**[View] Menu**

It is possible to select the display mode.

**Item View**

Here, it is possible to select items for view in the display. Note that items which have not been selected will also not be printed in the Data List.

1. Open [Item View] from the [View] menu.

2. Remove the check mark from item(s) you wish not to view.

3. Click the [OK] button to refresh the Data Viewer display.
Changing Temperature Unit
In the [View] Menu under [Temperature Unit], select [Celsius] or [Fahrenheit] to change the unit of temperature used in the Data Viewer to display measurements and Upper / Lower Limits.

Changing Date / Time Format
Use [Date/Time Format] in the [View] Menu to change the format in which Date / Time is displayed in the Data Viewer.

There are three types of Date / Time display formats.
[Month / Date / Year / Hour : Minutes' Seconds]
[Date / Month / Year / Hour : Minutes' Seconds]
[Year / Month / Date / Hour : Minutes' Seconds]
Changing the Display Widths

For easy viewing, it is possible to change the display area widths of the Data List and Remote Unit Info area. In the [View] Menu, select [Split] and drag the line which appears to the left or right.
6. Others
Recorded Data and Log Data

The recorded data and communication log (com. log) data for which a saving location has not been previously assigned in [Operational Settings] ("Communication" Menu) in "RTR-61 for Windows" will be automatically saved into the same program file in the disk where "RTR-61 for Windows" was installed.

- The Saving Location can be changed.

Opening a Program File (one example)

1. In the Windows Menu, in [My Computer], double click on [Local Disk].

2. The [Program Files] folder contains currently installed programs which have been saved to here.

3. Select the [RTR-61 for Windows (US)] folder and open it. In the [RTR-61 for Windows (US)] folder, the recorded data and communication log data will have already been saved.

: Communication log data for communications with Remote Units

: Folder where downloaded data has been saved
Troubleshooting

Network Settings Utility

Q.1 The following message appears "Windows Security Alert", what should I do?

A If you are using Windows XP SP2, the following message may be displayed.

![Windows Security Alert]

There is no problem, so please click [Unblock].

Q.2 Is it possible to use the [Network Settings Utility] via a proxy server?

A Communication is impossible via a proxy server.

Q.3 I cannot run a search in the Network Initialization. Why?

A One of the following may be the reason:
- Power is not being supplied by the AC adaptor to the RTR-5W.
- The RTR-5W and the computer you are using are not on the same network.
- The [Network Settings Utility] is already being used by another computer.
- The LAN card which is being used has not been formatted.

Q.4 I cannot make settings in the Network Initialization, Why?

A One of the following may be the reason.
- The Login ID and / or Password are incorrect.
- Another RTR-5W with the same IP address is on the same network.

Q.5 Why does a "Communication Error (Connection Error)" appear?

A The network is probably not properly connected.
- One of the following is incorrect: IP address or Domain, Login ID, Password, or Port Number.
- The network is not properly connected (the LAN cable is broken, the Hub is damaged, a mistake occurred in setting up the router, etc...).
- In the "Menu"-" Communication Time Settings" try slowing the communication time.
Q.6  Because of some other [Communication Error] communication cannot occur. Why?

A  One of the following may be the reason:
   - The IP Block setting is ON and communication can occur with only specific
     PC’s.
   - If after several attempts a communication error continues to occur, turn OFF
     the RTR-5W and restart.
   - If a sending error occurs, processing takes time, so please wait for at least one
     minute before trying again.

Q.7  Which has priority, a wireless LAN or a wired LAN?

A  If a wireless LAN card is inserted, the wireless LAN will have priority. Because of this, if the wireless LAN settings are incorrect and a wired LAN is connected, communication will not take place via the wired LAN and hence communication will not occur.

Q.8  I forgot the password, what should I do?

A  First, return the settings to the factory default settings and then redo the
    settings.

Q.9  Is it possible to hide the IP address history and settings history?

A  If you wish to disable the History, in the "Menu", select [Login History] and
    click to "OFF".
    Please note that a history will remain viewable from when before it was
    disabled. To erase a history, please click on "Clear Login History" in the
    Menu.
Q&A

Q&A about RTR-5W

Q.1 RTR-5W units use an AC adaptor, what happens when there is power shortage?

A During a power shortage the Web Server will not function and communication via LAN cannot occur.

Q.2 Can I connect directly to my computer with the LAN cable that comes with the logger?

A To connect a RTR-5W logger directly to your computer, you must use a cross LAN cable.
   The LAN cable supplied is a straight LAN cable and cannot be used to connect directly to your computer.
   Please purchase a cross LAN cable at your local computer supply store.

Q.3 Is it possible to connect the RTR-5W to the network by using the LAN cable that connects the computer to the LAN network?

A Inserting the wireless LAN cable that connects the computer to the network into the RTR-5W will physically connect the RTR-5W to the network, but without making the necessary settings such as IP address, the RTR-5W cannot be active in the network and hence is not really connected.
   After having inserted the LAN cable, make sure to go to [Network Settings Utility] to make the necessary IP address and subnet mask settings.

Q.4 Is it possible to connect to a wireless LAN by removing the wireless LAN card from my computer and using it?

A It is necessary to make Wireless LAN settings.
   In [Network Settings Utility], under [Detailed Network Settings] make changes to the [Wireless LAN Settings]. After that, turn OFF the RTR-5W power, then insert the card and turn the power back ON.

Q.5 I want to use a wireless LAN, which products should I use?

A Please use only those CF type Wireless LAN cards that have been proven to be compatible and are suggested for use.

Q.6 Which has priority, a wireless LAN or a wired LAN?

A If the Wireless LAN is connected properly and all settings are correct, the Wireless LAN will have priority.
   * For information and updates concerning which wireless LAN cards can be used, please contact your local T&D dealer or representative.
Q&A about Networks

Q.1 What is a network?
A A network is a system in which a group of computers are connected by cable (copper wire, optical fiber, etc), infrared ray, radio waves or other means in order to share and exchange information.
There are basically two types of computer networks.
A Local Area Network or LAN consists of a group or network of computers in a limited range.
A Wide Area Network or WAN is a network of computers that are connected over long distance. The Internet is an example of a WAN that has connected a multiple number of networks.

Q.2 What is an IP address?
A In a network, in order to distinguish your computer from another it is necessary to assign a number; this number is called an IP address.
When you connect to an outside network such as the Internet the IP address that is used is referred to as a "Global IP address. In a Local Area Network the IP address that is used is called a "Private IP address".
An IP address is divided into 4 blocks of numbers separated by periods, such as "192.168.15.10". The assigned numbers can use the digits 0-255 with private IP addresses usually beginning with numbers such as "192.168."
- However, the number "255." is not usually used.
- This number is absolutely necessary to enable participation in a network, so it is necessary to set the IP address to a number that suits your network environment.

Q.3 What is a Subnet mask?
A An IP address is made up of the network address to which the computer belongs (network address) and the computer's own address within the network (host address). The Subnet mask determines the division between these.

<table>
<thead>
<tr>
<th>IP Address</th>
<th>Network Address</th>
<th>Host Address</th>
</tr>
</thead>
<tbody>
<tr>
<td>192</td>
<td>168</td>
<td>15</td>
</tr>
<tr>
<td>255.</td>
<td>15</td>
<td>0</td>
</tr>
</tbody>
</table>

The Subnet mask, similar to the IP address, is made up of four blocks of numbers divided by periods, such as "255.255.255.0".
This number is absolutely necessary to enable participation in a network, so it is necessary to set the Subnet mask to a number that suits your network environment.
Q.4 How should I make settings for the IP address / Subnet mask?

A The IP address and Subnet mask settings vary depending upon your networking environment (structure). Please consult your network administrator for details. Below is a simplified explanation of a company LAN set up for your reference.

If the computer connected to your company LAN has a Subnet mask of "255.255.255.0" and an IP address of "192.168.100.1", set the Subnet mask to the same as your computer, "255.255.255.0".

Set the IP address to 192.168.100.***. Make sure to set the last three digits,***, to a number between 1-254 that is not the same as any other computer connected in your network.

<table>
<thead>
<tr>
<th>IP Address</th>
<th>192</th>
<th>168</th>
<th>100</th>
<th>1</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Q.5 What is a MAC address?

A A MAC address is a unique number made up of alphabet and numbers that is assigned separately to the components of network communication (computer, server, router, etc...). Each MAC address is assigned to the hardware and is unique to that device, so there is no chance for duplication.

Q.6 What is a port number?

A When using TCP/IP communication with a LAN cable or via a phone line, port numbers are assigned to distinguish one application from another. Port numbers can be assigned from 0 to 65535. The numbers 0 to 1023 are already reserved to communication services and are referred to as "Well Known Port Numbers".

[Well known port numbers] are: HTTP communication at 80 / FTP communication at 20 and 21 / SMTP communication (sending mail) at 25 / POP3 communication (receiving mail) at 110.

In order for communication to work properly these port numbers must be set correctly.
Q.7 What is a gateway?

A A gateway is a term used to refer to a device or software that is used to link networks with different standards.

For example, a gateway is needed when connecting a cell phone to the Internet or in any case where you wish to connect two devices that are completely different. Gateway carries with it the meaning of entrance and exit and a router may also be referred to with this term.

When making gateway settings, it is necessary to make IP address settings for the device that will act as a gateway.

Q.8 What is a URL?

A A URL is an address that is written in a way so that it is easy for the DNS function to determine on which server the IP address is located.

This address begins with "http:// " and is followed by such things as domain names, server names, port numbers, file names and other such info.

For example, if the IP address that is assigned to "www.tandd.com" is "61.197.203.107", by entering "http://61.197.203.107/product/rtr5W/tr_5w_01feature.html" in the browser, the same page will appear as when you enter "http://www.tandd.us/product/rtr_5w/rtr_5w_01feature.html".

*The DNS or Domain Name Server helps to switch difficult to understand IP address of just numbers, such as "61.197.203.107" into easy to grasp names such as "www.tandd.com" and helps connect to the desired server.
### Q&A about the Internet

<table>
<thead>
<tr>
<th>Q.1</th>
<th>What is a fixed IP address?</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>A</strong></td>
<td>Usually, when you connect to the Internet, the provider with which you have contracted service automatically assigns an IP address which may be different each time you connect, or may change after a certain length of time. With this type of changing IP address, it is more difficult for outsiders to illegally enter your computer. On the other hand, when using your computer or a RTR-5W unit as a sever, it would be necessary to enter a different IP address as the URL each time you wish to access it. In such a case, it would be necessary to find out the current IP address each time you wished to access and this would be totally inconvenient. To help solve this problem, there is something called a fixed IP address service that your provider can offer. With a fixed IP address, you will be assigned a special unique IP address. Some providers may give you a fixed IP address from the beginning of service, but with most providers it is necessary to sign up for this special service.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Q.2</th>
<th>How do you get a fixed IP address?</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>A</strong></td>
<td>A fixed IP address is a service offered by your Internet provider. For details about how to receive a fixed IP address, contact the Internet provider with which you are connected.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Q.3</th>
<th>How should I set up a fixed IP address?</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>A</strong></td>
<td>If you are using only one RTR-5W connected to one router, then the fixed IP address should not be set for the RTR-5W, but for the router. If you are using a multiple number of RTR-5W connected to one router, the RTR-5W will use FTP and HTTP so, please set a fixed IP address for each RTR-5W unit. Because it is impossible, when using normal ADSL or FTTH lines, to directly connect the RTR-5W to the Internet line, it is necessary to place a router between the logger and the ADSL (FTTH) modem. When using a router, the fixed Internet IP address should be assigned to the router and all access to the RTR-5W from outside should go through the router. In this case, the router will have two IP addresses: an external IP address for the Internet and an internal IP address for the company or household LAN.</td>
</tr>
</tbody>
</table>
Q.4 I want to use a URL without a fixed IP address, how can I do that?

A If you wish to access an RTR-5W by URL but without a fixed IP address, it is possible to use a dynamic DNS. The DNS or Domain Name Server helps to switch difficult to understand IP address of just numbers, such as "61.197.203.107" into easy to grasp names such as "www.tandd.co.jp" and helps connect to the desired server.

The DNS usually changes names to fixed IP addresses. But, if for some reason you cannot use a fixed IP address or for security reasons you wish not to use a fixed IP address, there is a type of DNS called a dynamic DNS, which can handle ever-changing IP addresses.

For example, the starting IP address is "210.0.0.1" and the URL associated with it is "http://www.rtr5w.com".

The IP address "210.0.0.1" is of the changing type that is periodically reassigned by the provider. After a certain period of time the assigned IP address is changed to "210.0.0.2".

Normally, at this point the DNS would not associate the URL with the IP address and access would be made impossible, but because the dynamic DNS tracks the IP address you can still access the desired server using the same URL. There are many types of dynamic DNS plans and services available, please contact your local provider for more details.

Q.5 Is it possible to connect to the Internet without a fixed IP address or an URL ?

A Yes it is possible to connect without using a URL or having a fixed IP address, but because the IP address that will be assigned by the provider will be constantly changing, the access will be varied and will not go smoothly.

For example, the IP address that you used successfully one hour before may no longer work and access will be made impossible. Further, you will have no way of verifying the new IP address.

We strongly suggest using either a fixed IP address or a dynamic DNS.

Q.6 If I connect the RTR-5W to the Internet, is it not possible that another person could read my data or change my settings?

A Yes, as long as you are connected to the Internet, the logger could well be the target of unwanted access.

And, as long as you are open on the Internet, it is possible that a third party could view your current readings or recorded data, or even, make changes to your settings.
Q&A about RTR-61 for Windows

Q.1 Wireless communication cannot occur. What should I do?

A.1 The battery power may be low in the Remote Unit (RTR-61) and/or Repeater(s) (RTR-50).

**How to Check Repeater’s Battery Level**

In the [RTR-61 Registration] window, select the Base Unit and then open the [Registration] Menu. Then select [Remote Unit/Repeater Registration]. Connect the Repeater (RTR-50) to the Computer with a USB cable.

![Help Menu](image)

From the [Help] Menu, select [RTR-50 Unit Version Info]. Then click on the [Gather] button to view the remaining battery level. If the message "Battery Power is low." appears, please change the battery.

![Gather Button](image)

**How to Check Remote Unit’s Battery Level**

- See "Battery Life Indicator" in the User’s Manual that accompanies the RTR-61 unit.
- Also, it is possible to view the remaining battery level in the [Get Remote Unit Info] ([Communication] Menu) in "RTR-61 for Windows."(See page 99 for details) If the remaining battery level falls below 20%, please change the batteries.

A.2 When communicating via Repeater(s), even if communication has been cancelled from the computer, wireless communication may still be in progress. Wireless communication among Repeaters and between a Repeater and Remote Units finishes automatically. Note however that a period exists before a communication is finished in which no new wireless communication can be started. Please allow enough time for this period and try again. If the LED lamp appears on the front of a Repeater that indicates a wireless communication is in progress.

A.3 Confirm that the RTR-50 Base Unit is properly connected to the computer with a USB communication cable.
A.4 Check to make sure that communication can occur between the RTR-5W Base Unit and the computer.

Q.2 The Remote Unit does not appear in the Remote Unit List. What should I do?

A The cause is probably because Registration Settings for the Remote Unit have not been properly made under "RTR-61 Registration". Please register the Remote Unit using "RTR-61 Registration".

Q.3 The Remote Measurement Command cannot be sent. Why?

A A multiple number of Remote Units may have been selected and/or the gathering of an Item Table may have not been carried out by the Remote Unit. Also, if the Recording Mode has not been set to "Remote" for the Remote Unit, Remote Measurement Commands cannot be carried out. It is possible to check the Recording Mode for the Remote Unit from [Get Remote Unit Info] under the [Communication] Menu.
Specifications

Software "RTR-61 for Windows"

Compatible Devices (Base Unit):

- RTR-50 (Wireless Communication Port):
  Unit Version 2-1-x or above

- RTR-5W (Network and Wireless Station):
  Internal Script Version 1.45 or above
  RF Version 1.4.x or above

PC Operating Environment

- OS
  Microsoft Windows 7 32/64bit English
  Microsoft Windows Vista 32bit English
  Microsoft Windows XP 32bit(SP2 or above) English

  * For installation, it is necessary to have Administrator (Computer Administrator) rights.

- Memory
  Enough memory to stably operate Windows®

- Hard Disk
  More than 20 MB of free space (Data will need more space)

- Monitor
  SVGA (higher than 800 x 600 recommended) more than 256 colors

- LAN
  100BASE-TX or 10BASE-T
  Twisted pair cable confirming to Category 5(STP/UTP)
To properly use "RTR-61 for windows (US)", the following operational environment is necessary.

<table>
<thead>
<tr>
<th>Base Unit</th>
<th>RTR-50</th>
</tr>
</thead>
<tbody>
<tr>
<td>Compatible Devices</td>
<td>RTR-61(Thermo Recorder Push Wireless)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Power</th>
<th>Base Unit: USB bus power</th>
</tr>
</thead>
<tbody>
<tr>
<td>Repeater:</td>
<td>2 AA batteries, External Power Voltage Input (DC 5.0V to 7.0V) [EIAJ-02 connector]</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Interface</th>
<th>USB: miniB Connector</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>* RTR-61 for Windows (US)&quot; can only be used when the PC communication connection is with a USB cable.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Wireless Communication Method</th>
<th>FCC Part15 Section249 / IC RSS-210</th>
</tr>
</thead>
<tbody>
<tr>
<td>Wireless Transmission Range</td>
<td>About 330ft (About 100m) If direct and unobstructed</td>
</tr>
</tbody>
</table>

| Communication Time | Wireless | 1 unit of full data takes about 6 minutes (when Repeaters Not Used) |
|                   |          | * When communicating via Repeaters, the approximate time for that communication is calculated |

| Communication Time | Optical | 1 unit of full data takes about 2 minutes and 30 seconds |

<table>
<thead>
<tr>
<th>LED Specifications</th>
<th>Green LED (Blink during Wireless Communication and PC Communication)</th>
</tr>
</thead>
</table>

| Battery Life       | 6 Months of continued as Repeater |
|--------------------| *Battery life depends upon the using environment, communication interval, and quality of the battery being used. |

<table>
<thead>
<tr>
<th>Dimensions</th>
<th>H 95mm x W 65mm x D 24.5mm</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Weight</th>
<th>Approx. 60g *Batteries not included</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Operating Voltage</th>
<th>2.5V to 7.0V</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Consumption Current</th>
<th>Max Approx. 50mA</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Operating Environment</th>
<th>Temperature: -10°C to 60°C (-30°C to 60°C when external power connected)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Humidity: Less than 90%RH (No condensation)</td>
</tr>
</tbody>
</table>

|-----------------------|---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------|

* For the Push Wireless Communication Set "RTR-61SK", it is impossible to use RTR-5 series data loggers in conjunction with the RTR-61. Please be fully aware of this before purchasing these products.
To properly use "RTR-61 for windows (US)" the following operational environment is necessary.

<table>
<thead>
<tr>
<th>Base Unit</th>
<th>RTR-5W</th>
</tr>
</thead>
<tbody>
<tr>
<td>Compatible Device</td>
<td>RTR-61(Thermo Recorder Push Wireless)</td>
</tr>
<tr>
<td>Power</td>
<td>Attached AC Adaptor (AD-0605)</td>
</tr>
</tbody>
</table>

**Communication Method**

- **FCC:** Part15 Section 249 / IC: RSS-210
- **Wired LAN:** 100 BASE-TX / 10BASE-T (RJ45 Connector)
- **Wireless LAN:** IEEE802.11b (CF Wireless LAN Card)
  *For information and updates concerning which wireless LAN cards can be used, please contact your local T&D dealer or representative.*

**Wireless Transmission Range**

- About 330ft (About 100m) If direct and unobstructed

**Communication Time**

- **Wireless:** 1 unit of full data takes about 6 minutes (when Repeaters Not Used)
  * When communicating via Repeaters, the approximate time for that communication is calculated
- **Optical:** 1 unit of full data takes about 2 minutes and 30 seconds

**LED Specifications**

- **LED Lamp Display:** (Power ON, Wireless Communication in Progress)

**Dimensions**

- H83 x W102 x D28 mm (excluding protrusions)

**Weight**

- Approx. 137g

**Consumption Current**

- MAX Approx. 300mA

**Operating Environment**

- **Temperature:** 0°C to 60°C
- **Humidity:** 20% to 80%RH (without condensation)

**Package of contents**


* For the Push Wireless Communication Set "RTR-61SK-W", it is impossible to use RTR-5 series data loggers in conjunction with the RTR-61. Please be fully aware of this before purchasing these products.
Options

For RTR-50 (When used as a Repeater)

AC-Adaptor

Input: AC 120V
Output: DC 6V  50mA
Frequency: 60Hz

For details, contact your local representative or dealer.

For RTR-5W

AC-Adaptor (AD-0605)

Cable Length:1.85m
Input: AC 100V (90-132V)
Output: DC 5V  2A
Frequency: 50 / 60Hz

Wall Attachment : TR-5WK1

Double-sided Adhesive Tape x 1
Materials : Polycarbonate
For product information or questions contact us at:

T&D Corporation
Shimadachi 817-1, Matsumoto, Nagano 390-0852 JAPAN
Tel: +81-263-40-0131    Fax: +81-263-40-3152    E-mail: support@tandd.com

Website:
We have opened an English Website for your convenience. Here you can find information about our company, news, products, upcoming events, software and User’s Manual downloads, as well as, other support. Please stop by and see what we have to offer.

http://www.tandd.com/


- RTR-5W Wireless and Network Station
- RTR-50 Wireless Communication Port

Published: 2010. 10 (4th Edition)

© Copyright T&D Corporation. All rights reserved.

This is printed on recycled paper.